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About This Book

Subject

Sybase® 1Q is a high-performance decision support server designed

specifically for data warehouses and data marts. This book, Sybase 1Q
System Administration Guide, presents the concepts and procedures
necessary for the administration of Sybase 1Q.

Audience

Thisguideisfor system and database administrators and for anyone who

needsto set up or manage Sybase 1Q. Familiarity with relational database
systems and introductory user-level experience with Sybase 1Q is
assumed. Use this guide with other manuals in the documentation set.

How to use this book

The following table shows which chapters fit a particular interest or need.

Table 1: Guide to using this book

To learn how to...

Read this chapter...

Understand the role of an Sybase 1Q administrator

Chapter 1, “Overview of Sybase IQ System
Administration”

Start and stop an |Q database server, and set up user
connections

Chapter 2, “Running Sybase 1Q”

Set up user connections

Chapter 3, “Sybase 1Q Connections’ and Chapter 4,
“Connection and Communication Parameters’

Create an Sybase 1Q database

Chapter 5, “Working with Database Objects”

Select Sybase 1Q indexes

Chapter 6, “Using Sybase |Q Indexes”

Load datainto your database

Chapter 7, “Moving Data In and Out of Databases’

Create procedures and batches

Chapter 8, “Using Procedures and Batches’

Specify constraints on the data in your tables

Chapter 9, “Ensuring Data Integrity”

Understand how transactions work

Chapter 10, “Transactions and Versioning”

Set up your database for the language you work in

Chapter 11, “International Languages and Character
Sets’

Add users and assign them privileges

Chapter 12, “Managing User 1Ds and Permissions’

Protect the confidentiality and integrity of data passing
between aclient and the Sybase 1Q server

Chapter 13, “Transport-Layer Security”

Back up and restore databases

Chapter 14, “Data Backup, Recovery, and Archiving”

Set up |Q for use as an Open Server™

Chapter 15, “Sybase |Q as a Data Server”

Configure Sybase | Q to access remote data
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Chapter 16, “Accessing Remote Data”
Chapter 17, “ Server Classes for Remote Data Access’
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To learn how to...

Read this chapter...

Automate database administration tasks using Chapter 18, “Automating Tasks Using Schedules and

scheduling and event handling

Events’

Use Javatoolsto access XML documentsin Sybase 1Q | Appendix A, “XML in the Database”

Use JDBC to access data

Appendix B, “Data Access Using JDBC”

Use the Sybase debugger

Related documents
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Appendix C, “Debugging Logic in the Database’

Documentation for Sybase |Q:

Introduction to Sybase IQ

Read and try the hands-on exercisesif you are unfamiliar with Sybase 1Q
or the Sybase Central™ database management tool.

New Featuresin Sybase 1Q 12.7
Read just before or after purchasing Sybase 1Q for alist of new features.
Sybase 1Q Performance and Tuning Guide

Read to understand query optimization, design, and tuning issuesfor very
large databases.

Sybase 1Q Reference Manual

Read for afull description of the SQL language, stored procedures, data
types, and system tables supported by Sybase |Q.

Sybase 1Q Troubleshooting and Recovery Guide
Read to solve problems and perform system recovery and database repair.
Sybase 1Q Error Messages

Refer to 1Q error messages (referenced by SQL Code, SQL State, and
Sybase error code) and SQL preprocessor errors and warnings.

Sybase 1Q Utility Guide

Read for Sybase 1Q utility program reference material, such as available
syntax, parameters, and options.

Sybase 1Q Installation and Configuration Guide

Read the edition for your platform before and while installing Sybase | Q,
when migrating to a new version of Sybase |Q, or when configuring
Sybase |Q for a particular platform.
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e SYybaselQ Release Bulletin

Read just before or after purchasing Sybase 1Q for last minute changes to
the product and documentation. Read for help if you encounter a problem.
¢ Large Objects Management in Sybase 1Q

Read to understand storage and retrieval of Binary Large Objects
(BLOBS) and Character Large Objects (CLOBSs) withinthe Sybase1Q data
repository. You need a separate license to install this product option.

¢ Encrypted Columnsin Sybase IQ

Read to understand the use of user encrypted columns within the Sybase
1Q datarepository. You need a separate license to install this product
option.

Sybase 1Q and Adaptive Server Anywhere
Because Sybase |Q is an extension of Adaptive Server® Anywhere, a

component of SQL Anywhere® Studio, |Q supports many of the samefeatures
as Adaptive Server Anywhere. The |Q documentation set refers you to SQL
Anywhere Studio documentation where appropriate.

Documentation for Adaptive Server Anywhere:
*  Adaptive Server Anywhere Programming Guide

Intended for application developers writing programs that directly access
the ODBC, Embedded SQL ™, or Open Client™ interfaces, this book
describes how to develop applications for Adaptive Server Anywhere.

*  Adaptive Server Anywhere Database Administration Guide

Intended for all users, this book covers material related to running,
managing, and configuring databases and database servers.

*  Adaptive Server Anywhere SQL Reference Manual

Intended for all users, thisbook providesacomplete referencefor the SQL
language used by Adaptive Server Anywhere. It also describes the
Adaptive Server Anywhere system tables and procedures.

You can al so refer to the Adaptive Server Anywhere documentation in the SQL
Anywhere Studio 9.0.2 collection on the Sybase Product Manuals Web site. To
access this site, go to Product Manuals at
http://www.sybase.com/support/manuals/.
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Other sources of Use the Sybase Getting Started CD, the SyBooks CD, and the Sybase Product
information Manuals Web site to learn more about your product:

*  The Getting Started CD contains release bulletins and installation guides
in PDF format, and may also contain other documents or updated
information not included on the SyBooks CD. It isincluded with your
software. To read or print documents on the Getting Started CD, you need
Adobe Acrobat Reader, which you can download at no charge from the
Adobe Web site using alink provided on the CD.

»  The SyBooks CD contains product manuals and is included with your
software. The Eclipse-based SyBooks browser allows you to access the
manuals in an easy-to-use, HTML-based format.

Some documentation may be provided in PDF format, which you can
accessthrough the PDF directory on the SyBooks CD. To read or print the
PDF files, you need Adobe Acrobat Reader.

Refer to the SyBooks I nstallation Guide on the Getting Started CD, or the
README.txt file on the SyBooks CD for instructions on installing and
starting SyBooks.

*  The Sybase Product Manuals Web siteis an online version of the SyBooks
CD that you can access using a standard Web browser. In addition to
product manuals, you will find links to EBFs/Maintenance, Technical
Documents, Case Management, Solved Cases, newsgroups, and the
Sybase Developer Network.

To access the Sybase Product Manuals Web site, go to Product Manuals at
http://www.sybase.com/support/manuals/.

» Infocenter isan online version of SyBooks that you can view using a
standard Web browser. To access the Infocenter Web site, go to Sybooks
Online Help at http://infocenter.sybase.com/help/index.jsp.

Sybﬁse V(\:/eLtifications Technical documentation at the Sybase Web site is updated frequently.
on the We

[JFinding the latest information on product certifications

1 Point your Web browser to Technical Documents at
http://www.sybase.com/support/techdocs/.

Select Products from the navigation bar on the | eft.
Select a product name from the product list and click Go.

Select the Certification Report filter, specify atime frame, and click Go.

a b~ WD

Click a Certification Report title to display the report.
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[IFinding the latest information on component certifications

1 Point your Web browser to Availability and Certification Reports at
http://certification.sybase.com/.

2  Either select the product family and product under Search by Product; or
select the platform and product under Search by Platform.

3 Select Search to display the availability and certification report for the
selection.

[ ICreating a personalized view of the Sybase Web site (including support
pages)

Set up aMySybase profile. MySybaseisafree servicethat allowsyou to create
apersonalized view of Sybase Web pages.

1 Point your Web browser to Technical Documents at
http://www.sybase.com/support/techdocs/.

2 Click MySybase and create a MySybase profile.

Sybase EBFs and
software
maintenance

[IFinding the latest information on EBFs and software maintenance
1 Point your Web browser to the Sybase Support Page at

http://lwww.sybase.com/support.

2 Select EBFs/Maintenance. If prompted, enter your MySybase user name
and password.

Select a product.

4 Specify atime frame and click Go. A list of EBF/Maintenance releasesis
displayed.

Padlock icons indicate that you do not have download authorization for
certain EBF/Maintenance releases because you are not registered as a
Technical Support Contact. If you have not registered, but have valid
information provided by your Sybase representative or through your
support contract, click Edit Roles to add the “ Technical Support Contact”
role to your MySybase profile.

5 Click the Info icon to display the EBF/Maintenance report, or click the
product description to download the software.

Syntax conventions This documentation uses the following syntax conventionsin syntax
descriptions:
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Keywords SQL keywords are shown in UPPER CASE. However,
SQL keywordsare caseinsensitive, so you can enter keywordsin any case
you wish; SELECT isthe same as Select which is the same as select.

Placeholders Itemsthat must be replaced with appropriateidentifiers
or expressions are shown in italics.

Continuation Lines beginning with ... are a continuation of the
statements from the previousline.

Repeating items Lists of repeating items are shown with an element
of the list followed by an ellipsis (three dots). One or more list elements
are alowed. If more than one is specified, they must be separated by
commeas.

Optional portions Optiona portions of a statement are enclosed by
square brackets. For example:

RELEASE SAVEPOINT [ savepoint-name ]

It indicates that the savepoint-name is optional. The square brackets
should not be typed.

Options When none or only one of alist of items must be chosen, the
items are separated by vertical bars and the list enclosed in square
brackets. For example:

[ ASC | DESC ]

It indicates that you can choose one of ASC, DESC, or neither. The square
brackets should not be typed.

Alternatives When precisely one of the options must be chosen, the
aternatives are enclosed in curly braces. For example:

QUOTES { ON | OFF }

It indicates that exactly one of ON or OFF must be provided. The braces
should not be typed.

Table 2 lists the typographic conventions used in this documentation.
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The sample
database

Accessibility
features

Table 2: Typographic conventions

Iltem Description

Code SQL and program code is displayed in a mono-spaced
(fixed-width) font.

User entry Text entered by the user is shown in bold serif type.

emphasis Emphasized words are shown iniitalic.

file names File names are shown in italic.

database objects | Namesof database objects, such astables and procedures,
are shown in bold, san-serif type in print, and in italic
online.

Sybase | Q includes a sampl e database used by many of the examplesinthe 1Q
documentation.

The sample database represents a small company. It contains internal
information about the company (employees, departments, and financial data),
aswell as product information (products), sales information (sales orders,
customers, and contacts), and financial information (fin_code, fin_data).

The sample database is held in a file named asigdemo.db, located in the
directory $ASDIR/demo on UNIX systems and %ASDIR%\demo on Windows
systems.

This document is availablein an HTML version that is speciaized for
accessibility. You can navigate the HTML with an adaptive technol ogy such as
a screen reader, or view it with a screen enlarger.

Sybase1Q 12.7 and the HTML documentation have been tested for compliance
with U.S. government Section 508 A ccessibility requirements. Documentsthat
comply with Section 508 generally al so meet non-U.S. accessibility guidelines,
such as the World Wide Web Consortium (W3C) guidelines for Web sites.

For information about accessibility support inthe Sybase | Q plug-infor Sybase
Central, see “Using accessibility features’ in Introduction to Sybase |Q. The

online help for this product, which you can navigate using a screen reader, also
describes accessibility features, including Sybase Central keyboard shortcuts.

Configuring your accessibility tool
You might need to configure your accessibility tool for optimal use. Some

screen readers pronounce text based on its case; for example, they pronounce
ALL UPPERCASE TEXT asinitials, and MixedCase Text as words. You
might find it helpful to configure your tool to announce syntax conventions.
Consult the documentation for your tool and see “ Using screen readers’ in
Introduction to Sybase 1 Q.
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For information about how Sybase supports accessibility, see Sybase
Accessibility at http://www.sybase.com/accessibility. The Sybase Accessibility
siteincludes links to information on Section 508 and W3C standards.

For a Section 508 compliance statement for Sybase |Q, go to Sybase
Accessibility at http://www.sybase.com/products/accessibility.

If you need help Each Sybase installation that has purchased a support contract has one or more
designated people who are authorized to contact Sybase Technical Support. If
you cannot resolve aproblem using the manuals or online help, please have the
designated person contact Sybase Technical Support or the Sybase subsidiary
inyour area.
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CHAPTER 1 Overview of Sybase IQ System
Administration

About this chapter This chapter provides a brief introduction to Sybase 1Q and an overview
of 1Q system administration.

Contents Topic Page
Introduction to Sybase 1Q 2
System administration tasks 3
Security overview 4
Tools for system administration 5
The database server 6
Catalogsand 1Q 6
Stored procedures 10
System tables and views 16
Commands and functions 21
Message logging 23
The utility database 26
Managing very |large databases 26
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Introduction to Sybase 1Q

Introduction to Sybase IQ

Sybase database
architecture

Rapid access to many
data sources

Data warehousing and
Sybase 1Q

Sybase | Q isahigh-performance decision support server designed specifically
for data warehousing. This cross-platform product runs on several popular
Unix platforms, aswell as Windows X P and Windows 2000.

Sybase|Qispart of the Adaptive Server family that includes Adaptive Server
Enter prise for enterprise transaction and mixed workload environments and
Adaptive Server Anywhere, asmall footprint version of Adaptive Server
often used for mobile and occasionally connected computing.

Sybase database architecture provides acommon code base for Sybase |Q and
Adaptive Server Anywhere, with workload optimized data stores. You use the
IQ Store for data warehousing. These products share a common command
syntax and user interface, allowing easier application development and user
access.

Sybase | Q can integrate data from diverse sources—not just 1Q databases, but
other databasesin the Adaptive Server family, aswell asnon-Sybase databases
and flat files. You can import this data into your |Q database, so that you can
take advantage of 1Q's rapid access capabilities. You can aso query other
databases directly, using Sybase 1Q's remote data access capabilities.

Data war ehouses are collections of data designed to allow business analysts
to analyze information. They are typically distinct from production databases,
to avoid interrupting daily operations. Data warehouses are often used as data
stores on which to build decision support systems (DSS). A decision support
system is a software application designed to allow an organization to analyze
datain order to support business decision making.

All of Sybase |Q's capabilities are designed to facilitate DSS applications. A
unique indexing system speeds data analysis. Query optimization gives you
rapid responses, even when results include thousands or millions of rows of
data. Concurrent dataaccess for multiple query users, and the ability to update
the database without interrupting query processing, provide the 24—hour, 7—
day accessthat users expect.

Sybase |Q multiplex capability isdesigned to manage large query | oads across
multiple nodes. Multiplex capability supports many users, each executing
complex queries against the shared database. With each server running Sybase
IQ and a shared disk subsystem connected to all servers, you can match I/O
operationsto CPU capabilities and scale the user community past the limits of
asingle server. Sybase |Q multiplexes also offer higher availahility, asfailures
of asingle node leave all other nodes up and running. You can attach as many
servers as the disk subsystem supports. For more about multiplex capability,
see “Multiplex capability” on page 8.
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Learning more about

This book explains how you manage a Sybase 1Q system. It isintended for
Sybase 1Q

database administrators and others who need to understand database creation,
load, and operation issues. “ About This Book™” describes other documentation
helpful to administrators.

System administration tasks

Typically, the database administrator (DBA) isresponsible for the tasks listed
on the left side of the following table. Look at the right side of the table to see

where these tasks are explained in this or other manuals.

Table 1-1: Administrative tasks
If you want to know how to...

Lookin...

Install and configure Sybase 1Q for your
platform

Sybase 1Q Installation and
Configuration Guide

Start and stop the database server

Chapter 2, “Running Sybase 1Q”

Set up or manage user connections

Chapter 3, “ Sybase 1Q Connections”
and Chapter 4, “Connection and
Communication Parameters’

Create a Sybase | Q database (with or
without multiplex capability)

Chapter 5, “Working with Database
Objects’

Determine appropriate indexes for your
users queries

Chapter 6, “Using Sybase |Q Indexes”

Load data into your database

Chapter 7, “Moving Data In and Out of
Databases”

Create procedures and batches

Chapter 8, “Using Procedures and
Batches’

Ensure the integrity of datain your tables

Chapter 9, “Ensuring Data I ntegrity”

Understand how transactions impact
concurrency

Chapter 10, “Transactions and
Versioning”

Set up your database for the language you
work in

Chapter 11, “International Languages
and Character Sets’

Add users, assign them privileges, and
manage logins

Chapter 12, “Managing User IDs and
Permissions”

Back up and restore databases

Chapter 14, “Data Backup, Recovery,
and Archiving”

Tune Sybase |Q for maximum
performance

System Administration Guide
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Security overview

Monitor |1Q performance

Sybase 1Q Performance and Tuning
Guide

Set up 1Q for use as an Open Server

Chapter 15, “Sybase |Q as a Data
Server”

Configure Sybase | Q to accessremote data

Chapter 16, “ Accessing Remote Data”

Chapter 17, “ Server Classesfor Remote
Data Access’

Automate database administration tasks
using scheduling and event handling

Chapter 18, “Automating Tasks Using
Schedules and Events’

Use Javatoolsto access XML documents

in Sybase 1Q

Appendix A, “XML in the Database’

Use Javain a Sybase 1Q database

Appendix B, “Data Access Using
JoBC”

Appendix C, “Debugging Logic in the
Database”

Diagnose 1Q server conditions

Chapter 1, “ Troubleshooting Hints’ in
Sybase |Q Troubleshooting and Error
Messages Guide

Verify or recover your database

Security overview

The DBA isresponsible for maintaining database security. Sybase 1Q provides
security controls by means of the privileges you can assign to users.

Types of users

Chapter 2, “ System Recovery and
Database Repair” in Sybase 1Q
Troubleshooting and Error Messages
Guide

Sybase | Q recogni zes three categories of users for each 1Q database:

The database administrator, or DBA, has compl ete authority to perform all
operations on that database. Thisguideisaddressed primarily tothe DBA,
who typically carries out most administrative tasks.

The user who creates a particular database object isits owner, and can
perform any operation on that object.
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All other users are considered public users. The owner of an objectis
considered a public user for objects owned by other users.

Granting permissions

Except for the DBA, who can perform any task, users must be granted the
authority to perform specific tasks. For example, you need the proper authority

to:

Connect to a database.

Create database objects, such as a database, table, index, or foreign key.
Alter the structure of database objects.

Insert, update, or delete data.

Select (view) data.

Execute procedures.

The DBA can grant any type of authority to any user. Sometimes other users
can grant authority aswell. For more information on what users can do, and
how the DBA manages users, see Chapter 12, “Managing User IDs and
Permissions.”

Tools for system administration
To help you manage your database, Sybase |Q provides two primary tools:

System Administration Guide

Sybase Central isan application for managing Sybase databases. It helps
you manage database objects and perform common administrative tasks
such as creating databases, backing up databases, adding users, adding
tables and indexes, enabling databases for multiplex capability, and
monitoring database performance. Sybase Central has a Java-based
graphical user interface, and can be used with any operating system that
allows graphical tools.

DBISQL, aso caled Interactive SQL, isan application that allowsyou to
enter SQL statementsinteractively and send them to a database. DBISQL
has awindow-like user interface on all platforms. Sybase | Q supports both
a Java-based DBISQL, and the C-based DBISQL provided in previous
releases.



The database server

The Introduction to Sybase 1Q explains how to use Sybase Central and
DBISQL to perform simple administrative tasks. If you are not already familiar
with these tools, you should read about them in the Introduction to Sybase 1Q
and use the tutorials provided there.

In addition to these tools, Sybase 1Q provides a number of stored procedures
that perform system management functions. See “ Stored procedures’ on page
10for moreinformation. You can & so create your own procedures and batches.
You may wish to take advantage of 1Q’s event-handling capability to develop
your own system management tools. See Chapter 18, “ Automating Tasks
Using Schedules and Events’ for details.

In addition to the stored procedures, Sybase |Q provides atool to monitor the
performance of its buffer caches. This monitor collects statistics on the buffer
cache, memory, and I/O functions taking place within Sybase |Q, and stores
themin alog file. See Sybase |Q Performance and Tuning Guide for details.

A few administrative tasks, such as selecting acollation, rely on command-line
utilities. These utilities are discussed in other chapters of this book, and
described in the Sybase 1 Q Reference Manual.

The database server

The database server isthe “brain” of your Sybase 1Q system. Users access
datathrough the database server, never directly. Requestsfor information from
a database are sent to the database server, which carries out the instructions.

Catalogs and IQ
An 1Q database is ajoint data store consisting of at |east three parts:
*  Thepermanent I1Q Store
* ThelQ Temporary Store
» TheCatalog Store

When you create an | Q database, all three stores are created automatically. You
create | Q databases using the procedures described in Chapter 5, “Working
with Database Objects.”

6 Sybase 1Q
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The 1Q Store

An 1Q database may also have an |Q Message Store and (on amultiplex query
server) an 1Q Local Store.

The1Q Storeisthe set of Sybase 1Q tables. You can have one or more
permanent 1Q Stores, each in a separate database. Each 1Q Storeincludes a set
of tablesthat organize your data. The table datais stored in indexes, which are
structured to allow rapid response to varioustypes of analytical querieson very
large quantities of data. The |Q Store is sometimes referred to asthe IQ Main
Store.

The 1Q Temporary Store

ThelQ Temporary Sore consists of a set of temporary tables. The database
server uses them for sorting and other temporary processing purposes.

The Catalog Store

The Catalog Sore contains al of the information required to manage an 1Q
database. This information, which includes system tables and stored
procedures, residesin a set of tables that are compatible with Adaptive Server
Anywhere. These tables contain the metadata for the |1Q database. Metadata
describes the layout of the IQ tables, columns, and indexes. The Catalog Store
is sometimes referred to simply as the Catalog.

Adaptive Server Anywhere and Sybase IQ

System Administration Guide

The Catalog Store closely resembles an Adaptive Server Anywhere store.
Adaptive Server Anywhereis arelational database system that can exist with
or without 1Q. You may have Adaptive Server Anywhere-style tablesin your
Catalog Store along with your 1Q tables, or you may have a separate Adaptive
Server Anywhere database.



Catalogs and 1Q

Anywhere tables have a different format than 1Q tables. While the commands
you use to create objectsin an Anywhere database are the same as those for an
I1Q Store, there are some differencesin the features you can specify in those
commands. Always use the command syntax in this book or the Sybase 1Q
Reference Manual for operationsin the |Q Sore.

This book explains how you manage your |Q Store and its associated Catalog
Store. If you have an Anywhere database, or if you have Anywhere-styletables
in your Catalog Store, see the Adaptive Server Anywhere documentation for
details of how to create, maintain, and use them.

For asummary of differences between Sybase 1Q and Adaptive Server
Anywhere, see Appendix A, “Compatibility with Other Sybase Databases,” in
the Sybase 1Q Reference Manual.

Concurrent operations

Sybase 1Q alows multiple users to query a database at the same time, while
another user inserts or deletes data, or backs up the database. Changes to the
structure of the database, such as creating, dropping, or altering tables,
temporarily exclude other usersfrom those tables, but queriesthat only access
tables el sewhere in the database can proceed.

Sybase 1Q keeps your database consistent during these concurrent operations
by maintaining multiple versions of table data. To understand this approach,
see Chapter 10, “ Transactions and Versioning.”

Multiplex capability

Oneway to manage alarge query load would beto copy the entire |Q database
to multiple machines. Extra servers could each run the same database, but after
changes at one of the servers, many of the files would have to be copied to the
other servers again. Once the |Q Store became very large, you would have to
purchaselotsof extradisk capacity, and copying the database would takealong
time.

Sybase 1Q
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1Q multiplex capability provides an effective alternative, where the 1Q Store
cost is reduced by sharing it, taking advantage of a shared disk subsystem.
Sybase |Q's vertical storage, compression and bitwise technology reduce 1/0
requirements dramatically, making it possible to have many systems sharing
the disk array(s) before contention degrades performance. You gain additional
CPU power and memory space for processing queries by attaching more
systems to the shared disk array. Multiplex capability lets auser perform loads
while other users query the database.

Figure 1-1: 1Q multiplex architecture
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Each set of an 1Q Temporary Store and Catalog Store comprise one server .

Inan 1Q multiplex, one server can load or update the database while the others
submit queries. The read-only servers submitting queries are called query
servers. The updating server isknown asthewrite server. By allowing only a
single write server, Sybase |Q multiplex eliminates the overhead and
scalability limits of a distributed lock manager.

Each server of amultiplex may start, stop, and operate independent of all the

others. Failure of any server does not prevent the other servers from operating.
Thereisno needto stop awriteserver. It isonly necessary to stop query servers
in extraordinary circumstances.

e Configuring a new write server
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* Restoring the query server loca store from backup
»  Performing forced recovery/drop leaks on alocal store on the query server
»  Starting the write server in single-node mode

The servers shareacommon |Q Store. Usersmay also create an |Q Local Store
on each query server, in which they can create and store persistent objects.
Such objects are visible to all users of that query server, but not to users on
other servers of the multiplex. For details see “ Populating persistent tablesin
multiplex databases’” on page 241.

The following sections provide more details about multiplex operation:
*  “Rulesfor running multiplex servers’ on page 34

e “Running the Sybase 1Q Agent” on page 35

o “Starting all serversin amultiplex” on page 41

»  “Creating databases with multiplex functionality” on page 193

e “Synchronizing query servers’ on page 204

e “Updating multiplex databases’ on page 212

*  “Creating tablesin multiplex databases’ on page 239

*  “Multiplex table version logging” on page 476

«  “Backing up and restoring the multiplex” on page 660

e “Multiplex server migration and failover” on page 663

Stored procedures

Sybase 1Q stored procedures help you manage your system. Stored
procedures give you information about your database and users, and carry out
various operations on the database. This section briefly describes the stored
procedures. For more information, see the Sybase |Q Reference Manual.

A stored procedure typically operates on the database in which you executeit.
For example, if you run the stored procedure sp_addlogin in the asigdemo
database, it adds a user to asigdemo.

10 Sybase 1Q
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You can also create your own stored procedures. See Chapter 8, “Using
Procedures and Batches” for details.

Note Statements shown in examples generally use the asigdemo database, a
sampledatabaseinstalled as part of Sybase | Q. For adiagram of thisdatabase’s
structure, see Introduction to Sybase | Q.

Sybase IQ stored procedures

The following procedures work specifically on the IQ Store. They are owned
by the DBA user ID.

Note Stored proceduresthat produce sizeinformation assumethat the database
was created with the default block size, as described in “Block size” in Sybase
IQ Performance and Tuning Guide. If a database was created with a non-
default block size, the output from the following stored proceduresis
inaccurate: sp_igestjoin, sp_igestdbspaces, sp_igestspace.

Table 1-2: Stored Procedures for the IQ Store

Procedure name

Purpose

sp_igaddlogin

Adds anew Sybase 1Q user account, and specifies the number of current
logins the user may have and the password expiration interval

sp_igcheckdb

Checks the validity of the current database and repairs indexes

sp_igcolumn

Displays columns in a database and information about them

sp_igconnection

Showsinformation about connections and versions, including which usersare
using temporary dbspace, which users are keeping versions alive, what the
connections are doing inside Sybase 1Q, connection status, and database
version status

sp_igconstraint

Lists referential integrity constraints for the specified table or column

sp_igcontext

Displays the currently executing statement for each active connection, or for
asingle connection

sp_igcursorinfo

Displays detailed information about cursors currently open on the
server

sp_igdatatype

Displays information about system data types and user-defined data
types

sp_igdbsize

Gives the size of the current database

sp_igdbspace

System Administration Guide

Lists detailed information including usage, properties, and types of data
on each dbspace.
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Procedure name

Purpose

sp_igdbspaceinfo

Displays the number of blocks user per index per main or local dbspace for
one or al dbspaces.

sp_igdbstatistics

Reports results of the most recent sp_igcheckdb

sp_igdroplogin

Dropsan 1Q login

sp_igestjoin

Estimates the space needed to create join indexes for the tables you specify

sp_igestdbspaces

Estimates the number and size of dbspaces needed for agiven total index size

sp_igestspace

Estimates the amount of space needed to create a database, based on the
number of rowsin the underlying database tables

sp_igevent Displaysinformation about system and user-defined events

sp_ighelp Displaysinformation about system and user-defined objects and data
types

sp_igindex Lists indexes and information about them. Omitting the parameter lists all

indexesin thedatabase. Specifying thetable_nameparameter listsindexesfor
this table only.

sp_igindexinfo

Displays the number of blocks user per index per main or local
dbspace for a given object.

sp_igindex_alt

Same as sp_igindex, except that for multicolumn indexesit lists one row for
each column.

sp_igindexsize

Gives the size of the specified index

sp_igjoinindex

Displays information about join indexes

sp_igjoinindexsize

Gives the size of the specified join index

sp_iglistexpiredpass
words

Lists user accounts with expired passwords

sp_iglistlockedusers

Lists locked user accounts

sp_iglistpasswordexpira
tions

Lists user accounts, their password creation dates, and number of days
password is valid from creation date

sp_iglocklogin

Locks an 1Q user account so that the user cannot log in

sp_iglocks

Shows information about locks in the |Q Store and the Catalog Store

sp_igmodifyadmin

Enables or disables Sybase |Q User Administration, and sets defaultsfor user
account characteristicsin the IQ_SYSTEM_LOGIN_INFO_TABLE system
table

sp_igmodifylogin

Modifies the maximum number of connections or the password expiration
interval for asingle user or al users

sp_igpassword

Adds or changes a password for an 1Q login account

sp_igpkeys

Displaysinformation about primary keysand primary key constraints
by table, column, table owner, or for al |Q tablesin the database

sp_igprocedure

Displays information about system and user-defined procedures

sp_igprocparm

12

Displaysinformation about stored procedure parameters, including
result set variables and SQL STATE/SQL CODE error values

Sybase 1Q



CHAPTER 1 Overview of Sybase 1Q System Administration

Procedure name

Purpose

Sp_ig_process_login

When the LOGIN_PROCEDURE database option is set to
sp_ig_process_login, determines which users can log on

sp_igrelocate

Relocates specified tables and indexes on main dbspaces in relocate
mode to main or local dbspaces in readwrite mode.

sp_igrename

Renames user-created tables, views, columns, indexes, constraints
(unique, primary key, foreign key, and check), stored procedures, and
functions

sp_igshowpsexe

Displays information about the settings of database options that
control the priority of tasks and resource usage for connections

sp_igspaceinfo

Lists the number of blocks used per object per dbspace.

sp_igspaceused

Shows information about space available and space used in 1Q Store and 1Q
Temporary Store

sp_igstatus Displays avariety of 1Q status information about the database

sp_igsysmon Monitors multiple components of Sybase |1Q, including the
management of buffer cache, memory, threads, locks, I/O functions,
and CPU utilization

sp_igtable Liststablesand information about them. Omitting the parameter listsall tables

in the database. Specifying the table_name parameter lists columns for this
table only.

sp_igtablesize

Gives the size of the specified table

sp_igtransaction

Shows information about transactions and versions

sp_iqview

Displays views in a database and information about them

sp_igwho

Displaysinformation about all current users and connections or about
aparticular user or connection

Note Several multiplex stored procedures are also available. See Chapter 10,
“System Procedures’ in Sybase |Q Reference Manual for more information.

Adaptive Server Enterprise system and catalog procedures

Adaptive Server Enterprise provides system and catal og procedures to carry
out many administrative functions and to obtain system information. Sybase
1Q has implemented support for some of these procedures.

System Administration Guide
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System procedures are built-in stored procedures used for getting reportsfrom
and updating system tables. Catalog stored procedures retrieve information
from the system tables in tabular form.

Note While these procedures perform the same functions asthey doin
Adaptive Server Enterprise and pre-Version 12 Sybase |Q, they are not
identical. If you have preexisting scripts that use these procedures, you may
want to examine the procedures. To see the text of a stored procedure, run

sp_helptext 'owner.procedure name'

For all system stored procedures delivered by Sybase, the owner isdbo. To see
the text of a stored procedure of the same name owned by a different user, you
must specify that user, for example:

sp_helptext 'myname.myprocedure'

You may need to reset the width of your DBISQL output to see thefull text, by

clicking Command > Options and entering a new Limit Display Columns

value.

Adaptive Server Enterprise system procedures

The following Adaptive Server Enterprise system procedures are provided in
Sybase |Q. These stored procedures perform important system management

tasks.
System procedure Description
sp_addgroup Adds a group to a database

sp_addlogin

Adds a new user account to a database

sp_addmessage

Adds user-defined messagesto
SY SUSERMESSAGES for use by stored
procedure PRINT and RAISERROR calls

sp_addtype

Creates a user-defined data type

sp_adduser

Adds a new user to a database

sp_changegroup

Changes auser's group or adds a user to a
group

sp_dboption

Displays or changes database options

sp_dropgroup

Drops a group from a database

sp_droplogin

Drops a user from a database

sp_dropmessage

Drops user-defined messages

sp_droptype
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Drops a user-defined data type
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System procedure

Description

sp_dropuser

Drops a user from a database

sp_getmessage

Retrieves stored message strings from
SYSMESSAGES and
SYSUSERMESSAGES for PRINT and
RAISERROR statements.

sp_helptext

Displays the text of a system procedure or
view

sp_password

Adds or changes a password for auser ID

Adaptive Server Enterprise catalog procedures

Sybase |Q implements all the Adaptive Server Enterprise catalog procedures
with the exception of the sp_column_privileges procedure. The implemented
catalog procedures are described in the following table.

Thefollowing list describes the supported Adaptive Server Enterprise catalog

procedures.
Catalog procedure Description
sp_column_privileges Unsupported

sp_columns

Returns the data types of the specified column

sp_fkeys

Returns foreign key information about the
specified table

sp_pkeys

Returns primary key information for asingle
table

sp_special_columns

Returns the optimal set of columns that
uniquely identify arow in atable

sp_sproc_columns

Returnsinformation about astored procedure's
input and return parameters

sp_stored_procedures

Returns information about one or more stored
procedures

sp_tables

Catalog stored procedures

Returns alist of objectsthat can appear in a
FROM clause

In addition to the Adaptive Server Enterprise Catal og stored procedures, there
are other system and catalog stored procedures. The following table lists the

ones you are most likely to use. For acomplete list, see Chapter 10, “ System
Procedures’ in Sybase 1Q Reference Manual.

System Administration Guide
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Procedure name Purpose

sp_remote_columns List remote tables columns and their
data types

sp_remote_exported_keys Get information about remote tables
with foreign keys on a specified
primary key table

sp_remote_imported_keys Get information about remote tables
with primary keys for a specified
foreign key

sp_remote_primary_keys Get primary key information about
remote tables

sp_remote_tables List tables on aremote server

sp_servercaps Display information about a remote
server's capabilities

System tables and views

Sybase 1Q system tables contain al of the information the database server
needs to manage your Sybase 1Q system. The system tablesreside in the
Catal og Store, and are sometimes called catal og tables. For some systemtables
there are also views that make it easier to display the information in the table.
The SY S user ID owns the system tables.

Among theinformation in the system tablesis:
»  Database characteristics

»  Tablecharacteristics, including table definitionsand information about the
size and location of each table

* Information about indexes
e Current settings for database and DBISQL options
System tables include:

System table Description

DUMMY A table with exactly one row, useful
for extracting information from the
database

1Q_MPX_INFO Contains information describing a
server in amultiplex database

Sybase 1Q
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System table

Description

IQ_MPX_STATUS

Containsdynamic information about a
server in amultiplex database

IQ_MPX_VERSIONLIST

Contains one row for each query
server in the multiplex.

IQ_SYSTEM_LOGIN_INFO

Stores system defaults for 1Q User
Administration

IQ_USER_LOGIN_INFO

Stores password expiration,
connection limit, and login lock status
for each |Q user ID

SYSARTICLE

Describes an articlein a SQL Remote
publication

SYSARTICLECOL

Describes columnsin each articlein a
SQL Remote publication

SYSCAPABILITY

Each row identifies a capability of a
remote server

SYSCAPABILITYNAME

Each row identifies a capability

SYSCHECK

Each row identifiesanamed check
constraint in atable

SYSCOLLATION

Contains the complete collation
sequences available to Sybase 1Q

SYSCOLLATIONMAPPINGS

Liststhe collation sequencesavailable
in Sybase 1Q and their GPG and JDK

mappings

SYSCOLPERM Records names of individual columns
with UPDATE permission
SYSCOLUMN Describes each column in every table

or view

SYSCONSTRAINT

Each row describesanamed constraint

SYSDOMAIN

Lists the number, name, ODBC type,
and precision of each predefined data

type

SYSEVENT

Describes events created with
CREATE EVENT

SYSEVENTTYPE

Describes system event types which
can be referenced by CREATE
EVENT

SYSEXTERNLOGINS

Describes external logins for remote
data access

SYSFILE
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Lists operating system files and
dbspace names for the database
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System table

Description

SYSFKCOL

Associates each foreign key column
with a primary key column

SY SFOREIGNKEY

Contains general information about
each foreign key

SYSGROUP Describes a many-to-many
relationship between groups and
members

SYSINDEX Describes indexes in the database

SYSINFO Describes database characteristics

SYSIQCOLUMN Listsinformation on columnsin every
table or view in the IQ Store

SYSIQFILE Listsinformation on operating system
filesfor the database

SYSIQINDEX Listsinternal information on indexes
in the database

SYSIQINFO Lists additional database

characteristics

SYSIQJOININDEX

Describes join indexes in the database

SYSIQJOINIXCOLUMN

Describes columns that participate in
join indexes

SYSIQJOINIXTABLE

Liststhetablesthat participatein each
join index in the database

SYSIQTABLE Describes each table or view inthe 1Q
Store

SYSIXCOL Describes each index for each column
in the database

SYSJIAR Describes each jar file associated with
the database

SYSJIARCOMPONENT Describes each jar component
associated with the database

SYSJAVACLASS Contains all information related to
Java classes

SYSLOGIN Lists User Profile names that can
connect to the database with an
integrated login

SYSOPTION Lists current SET OPTION settings
for all usersincluding the PUBLIC
user

SY SPROCEDURE Describes each procedure in the

database
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System table

Description

SY SPROCPARM Describes each parameter to every
procedure in the database
SY SPROCPERM Lists each user granted permission to

call each procedure in the database

SYSPUBLICATION

Describes each SQL Remote
publication

SYSREMOTEOPTION

Describes the values of SQL Remote
message link parameters

SYSREMOTEOPTIONTY PE

Describes the SQL Remote message
link parameters

SYSREMOTETYPE Contains information about SQL
Remote

SYSREMOTEUSER Describes user IDswith REMOTE
permissions and the status of their
SQL Remote messages

SYSSCHEDULE Describes the times at which events
aretofire

SYSSERVERS Describes remote servers

SYSSQLSERVERTY PE Contains information relating to

compatibility with Adaptive Server
Enterprise

SYSSUBSCRIPTION

Relates each user ID with REMOTE
permissions to a publication

SYSTABLE Describes one table or view in the
database

SYSTABLEPERM Describes permissions granted on
each table in the database

SYSTYPEMAP Contains the compatibility mapping
values for SY SSQLSERVERTY PE

SYSUSERMESSAGES Lists user-defined error messages and
their creators

SY SUSERPERM Lists characteristics of each user ID.
Because it contains passwords, you
need DBA permissions to select from
thistable

SYSUSERTYPE Describes each user-defined data type

SYSWEBSERVICE

Describes web services

System views present the information from their corresponding system tables
in amore readable format. In some cases, they omit password information so
that they can be accessible to all users. System views include:

System Administration Guide
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System view

Description

SYSARTICLECOLS

Presentsareadableversion of thetable
SYSARTICLECOLS

SYSARTICLES

Presentsareadableversion of thetable
SYSARTICLES

SYSCAPABILITIES

Presents areadable version of the data
from the tables SY SCAPABILITY
and SYSCAPABILITYNAM

SYSCATALOG Listsall tables and views from
SYSTABLE

SYSCOLAUTH Presents column update permission
information from SY SCOL PERM

SYSCOLUMNS Presentsareadableversion of thetable

SYSCOLUMN

SYSFOREIGNKEY S

Presentsforeign key information from
SY SFOREIGNKEY and SY SFKCOL

SYSGROUPS Presents group information from
SYSGROUP

SYSINDEXES Presentsindex information from
SYSINDEX and SY SIXCOL

SYSOPTIONS Displays option settings contained in
the table SY SOPTION

SYSPROCAUTH Presents a readable version of the
procedure authorities from
SYSUSERPERM

SYSPROCPARMS Lists all the procedure parameters
from SY SPROCPARM

SYSPUBLICATIONS

Presents the user name from

SY SUSERPERM for al creators and
displays areadable version of the
publication name and remarks from
SYSPUBLICATION

SYSREMOTEOPTIONS

Presents areadabl e version of the data
from SYSREMOTEOPTION and
SYSREMOTEOPTIONTY PE

SYSREMOTETYPES Presentsareadable version of the SQL
Remote information from
SYSREMOTETYPE

SYSREMOTEUSERS Liststheinformationin
SYSREMOTEUSER
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System view Description

SY SSUBSCRIPTIONS Presents a readable version of
subscription information from
SYSPUBLICATION

SYSTABAUTH Presents table permission information
from SY STABLEPERM
SYSUSERAUTH Displays all the information in the

table SY SUSERPERM except for user
numbers. Because it contains
passwords, this system view does not
have PUBLIC select permission
SYSUSERLIST Presents all information in
SYSUSERAUTH, except for
passwords

SYSUSEROPTIONS Displays effective permanent option
settings for each user
SYSUSERPERMS Containsexactly the sameinformation
asthe table SYS.SY SUSERPERM,
except the password is omitted

SYSVIEWS Lists views and their definitions

For a compl ete description of system tables and views and their contents, see
the Sybase |Q Reference Manual.

Commands and functions

All Sybase |Q commands are SQL statements. SQL stands for Structured
Query Language, alanguage commonly used in database applications. Sybase
1Q SQL uses the same syntax as Adaptive Server Anywhere SQL ; the only
differences are for certain product capabilities that are supported only for
Sybase 1Q or for Anywhere. Sybase |Q SQL also offers a high degree of
compatibility with Transact-SQL, the SQL dialect used by Adaptive Server
Enterprise.

This section introduces the types of commands and functions you can use.
Other chapters of this book tell you about the commands you use to perform
various administrative tasks. For complete detail s of supported commands and
functions, see the Sybase |Q Reference Manual.
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Types of SQL statements
You use three basic types of SQL statements:

Functions

DDL (Data Definition Language) statements let you define and modify
your database schema and table and index definitions. Examples of DDL
statements include CREATE TABLE, CREATE INDEX, ALTER TABLE, and
DROP.

DML (Data Manipulation Language) statements let you query your data,
and move datainto and out of the database. Examples of DML statements
include SELECT, SET, and INSERT.

Program control statements control the flow of program execution. They
do not operate directly on your Sybase |Q tables. Examples include IF,
CALL, and ROLLBACK.

Functionsreturninformation from the database. They are allowed anywhere an
expression is allowed. Sybase | Q provides functions that:

22

Aggregate data (for example, AVG, COUNT, MAX, MIN, SUM, STDDEYV,
VARIANCE)

Manipulate numeric data (for example, ABS, CEILING, SQRT,
TRUNCATE)

Manipulate string data (for example, LENGTH, SOUNDEX, UCASE)

Manipulate date and time data (for example, TODAY, DATEDIFF,
DATEPART, MINUTES)

Convert retrieved data from one format to another (CAST, CONVERT)

Manipulate analytical data (for example, DENSE_RANK, NTILE,
PERCENT_RANK, PERCENTILE_CONT, PERCENTILE_DISC, RANK)
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Message logging

An 1Q message log file exists for each database. The default name of thisfile
is dbname.igmsg. The 1Q message log file is created when the database is
created. Its default location isin the same directory as the Catalog Store,
although the database creator may specify another location.

I. 08/11 16:29:24.
I. 08/11 16:29:24.
I. 08/11 16:29:24.

By default, Sybase 1Q logsthe following types of messagesin the messagelog

file:

e Error messages

e Status messages

e Insert notification messages

e Query plans

You can examine thisfile as you would any other text file.

At the start of the file and when you start a database you see output like the

following:

0000000000
0000000000
0000000000

Pgsz=131072/8192blksz/16bpc

I. 08/11 16:29:24.
I. 08/11 16:29:24.
2000/32bit/2006-08-10 09:54:19
I. 08/11 16:29:24.
12 _7\demo\asigdemo.
29:24.
29:24.
29:24.
29:24.

I. 08/11
I. 08/11
I. 08/11
I. 08/11

16:
16:
16:
16:

Main

Main

Temporary I:

0000000000
0000000000

0000000000
db

0000000000
0000000000
0000000000
0000000000

OpenDatabase Completed

IQ

DB:

DB:
DB:

DB:

DB:

DB:
DB:

cmd line srv opts:
r/w, Main Buffs=127, Temp Buffs=95,

Frmt#: 23F/2T/1P (FF: 03/18/1999)
Versn: 12.7.0/040810/P/Mainline/MS/Windows

Name: C:\Program Files\Sybase\ASIQ-

Txn ID Seqg: 175

IQ Server fiona asigdemo

Database encryption is OFF.
Mem: 41mb/M41

Blks: U4541/80%, Buffers: U4/LO
Temporary Blks: U65/2%, Buffers: U4/LO
I: L16/P2 O: C2/D2/P0 D:0 C:100.0

L28/P0 O: C4/D4/PO D:0 C: 0.0

Version information in the igmsg file
Near the beginning of the file you see version information similar to the

following:

Versn: 12.7/060610/P/GA/Sun_svr4/0S 5.9/64bit/2006-06-10 02:49:46

System Administration Guide
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Table 1-3: Version string elements

Version string element | Example Comments

Major release 12.7 First 2 segments indicate major release

Minor release 12.7.n Third segment indicates minor release

Interna build number 060610

Internal build type P P = Production build

Release type GA GA = Genera Availability
ESD = Engineering Software Distribution (Maintenance)

Hardware platform Sun_svr4

Operating system version 0S 5.9 OSversion and hit mode refer to the system on which the
software was built, not where it is running currently

Bit mode 64bit

Build date and time 2006-06-10 Shown as YYYY-MM-DD hh:mm:ss (ISO datetime

02:49:46 format):

YYYY 4-digit year

MM  2-digit month number (0-12)

DD 2-digit day of month number (0-31)

hh 2-digit number of complete hours that have passed
since midnight (00-23)

mm  2-digit number of complete minutes that have
passed since the start of the hour (00-59)

ss 2-digit number of complete seconds that have passed
since the start of the minute (00-59)

Collation information in the igmsg file

When you start the database, an entry in the |Q messagelog showsthe collation
name, case sensitivity, blank padding state, and character trandation table
requirement. Comparisons are conditioned meansthat no trandation
tableis required when comparing character data.

Connection information in the igmsg file

The connection handle and database user name, shown in the last line of the
output example, are printed after thefirst transaction begins and before the next
transaction starts. Thisinformation is printed only once per database
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connection.
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You can use this connection information to match query plansin theigmsg file
with query text. Run the stored procedure sp_igcontext to determine what
statement each connection is executing at a given moment.

Note To correlate connection information in the -zr log file with that in the
.igmsg file, see “ Correlating connection information”in the Sybase 1Q
Troubleshooting and Recovery Guide.

Controlling the size of the igmsg file

The messagelog file continuesto exist until you drop the database. By default,
the file grows indefinitely. To control the length of this file you can enable
message log wrapping. The IQMSG_LENGTH_MB database option enables
message log wrapping, and sets the length of thisfile. When the file grows to
the specified size, new messages are written to the beginning the file,
overwriting existing messages. See Chapter 2, “ Database Options” in Sybase
IQ Reference Manual for details.

Alternatively, you can archive your message log while no users are connected
to the database, and then create a new, empty doname.igmsg file before
allowing another user to connect.

Moving the igmsg file in Sybase Central

When you create a query server, Sybase Central |ets you specify the location
of itsigmsg fileif you prefer a default location other than the catal og database
directory. In the Create Query Server wizard, on the Temporary DB
Information page, select the Override Default File Paths check box. In the

Specify the Path to the M essage Files pop-up box, type anew path to the .igmsg
file

Insert notifications in the igmsg file

Insert and load operations are also logged in the 1Q message file. For
information about insert notification messages logged in the igmsg file, see
“Interpreting notification messages’ on page 343.
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The utility database

The utility database is essentially a database that never holds data. The database
server usesit at timeswhen it needs a database to connect to, but either no real
database exists, or none should be running. Sybase | Q installation creates the
utility database automatically.

Be sure you do not delete this database. You need it to do any of these things:

»  Start the database server using the START ENGINE command with no
database specified

*  Create or drop a database when you have no other database to connect to

»  Start thedatabase server or connect to adatabase when any other databases
you have are unavailable, for example, due to mediafailure

* Restore adatabase

By default, the utility database has the user ID dba and the password sgl. You
can change these to other values during installation, or later by editing the
connection parametersin the util_db.ini file in your executable directory.

For more information on the utility database, see “ Utility database server
security” on page 564.

Managing very large databases
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Sybase |Q’s patented design features permit databasesto scal e to contain many
terabytes of data. Itsindex-based structure allows 1Q to store your datain a
much smaller space than the size of the raw input data, and accessit far faster
than atraditional relational database. These features make Sybase |Q ideal for
storing and accessing very large databases (VLDBS).

Database administrators need to understand the options and features that affect
performance, and follow documented guidelines. While many default settings
automatically providethe greatest efficiency, you may need to experiment with
certain option settings for the fastest results, based on your configuration, your
loading requirements, and your queries. Setting these options appropriately is
necessary for top performance in any Sybase 1Q database, but is especially
important as your database grows to the multiterabyte scale.

This section introduces Sybase | Q features that help you manage a very large
database, and points you to more detailed discussion and recommendations.
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Managing memory use

Allocating memory appropriately is akey factor in performance for al 1Q
databases. Sybase 1Q uses memory initsbuffer cachesfor loads and queries. It
also uses some memory for managing connections, transactions, buffers, and
database objects.

Sybase |Q has two buffer caches, one for the main 1Q Store and one for the
Temporary Store. A local store on aquery server shares the main buffer
cache.The default sizes of these caches are not sufficient for a production data
warehouse. You must adjust them to reflect the size of your database and tabl es,
your mix of loads and queries, and other factors such as your operating system
and other applications that can affect the amount of memory available.

For complete discussion of Sybase |Q memory use, server and database
options that determine your 1Q cache sizes, and other options that affect the
total available memory on some platforms, see*Managing System Resources,”
in Sybase 1Q Performance and Tuning Guide.

Managing data loads

Asyour database grows, it is crucial to manage data loading properly. Means
of ensuring that your loads can scale to meet your needs include:

< Buffer manager partitioning to avoid lock contention. Buffer partitioning
based on the number of CPUs is enabled by default, and can be adjusted
by setting server or database options. See “ Managing lock contention” on
page 489 for details.

»  Allowing sufficient memory for loads, without allocating more memory
than is available on your system.

*  Reserving spacefor datastructures used during rel ease savepoint, commit,
and checkpoint operations. See “MAIN_RESERVED DBSPACE_MB
option” and“TEMP_RESERVED DBSPACE_MB option” inthe Sybase
1Q Reference Manual.

For alist of other featuresthat help you manageload performance, see” Tuning
bulk loading of data’ on page 387.
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Managing processing threads

Sybase | Q uses operating system threads to process queries and loads. The
default settings of options that control thread use are usually sufficient to
provide good performance. In some cases, you may heed to change these
settings. See “ The process threading model” in Sybase 1Q Performance and
Tuning Guide to understand how Sybase | Q uses threads. See “ The database
server” in Sybase 1Q Performance and Tuning Guide to set server options that
control thread use.

Managing disk space

The most important factorsin managing disk I/O for an 1Q system are:
»  Having enough disk space for queries and loads

» Using that disk space effectively, so that the fastest I/O is available to
support the processing speed of high-powered, multi-CPU systems

The sp_igstatus stored procedure indicates the percentage of space used in the
IQ Main and Temporary Stores, so that you will know when you need to add
more space. sp_igdbspace provides additional details.

Disk striping is an important means of obtaining maximum 1/0O performance.
Disk striping distributes data randomly across multiple disk drives. You can
take advantage of disk striping capabilitiesin your operating system or disk
management software and hardware, as well as Sybase 1Q internal striping.
Sybase 1Q disk striping is enabled by default. To understand these disk
management techniques, see “Balancing I/O” in Sybase 1Q Performance and
Tuning Guide.

Intermediate versioning

28

A key aspect of managing loads and queriesin larger databasesis Sybase |Q's
transaction-level versioning. In particular, Sybase 1Q offers the ahility to roll
back transactions to intermediate save points, so that you may not need to
repeat the entireload if along transaction is unable to complete. To understand
how to best take advantage of this feature, see Chapter 10, “ Transactions and
Versioning”.
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Creating databases

Creating indexes

When you create your Sybase | Q databases, it isespecialy important to choose
the correct 1Q page size. For very large databases, you need an | Q page size of
128MB or larger. For more information, see “ Choosing an |Q page size” on
page 189.

Sybase |Q’s column-based indexing structure optimizesyour ability to perform
selections or calculations on attributes of interest to you. For the best
performance, you need the right set of indexes for your data and queries. Your
database should have an index on every column that affects performance. See
Chapter 6, “Using Sybase 1Q Indexes’ for details on choosing the right
indexes.

Optimizing queries

Schema design

The Sybase 1Q query optimizer eval uates every query, choosing among various
processing options to produce a query plan that offers optimal performance.
The optimizer istuned for each release of Sybase |Q to choose the best plan for
most queries and most databases, including the largest ones.

For information on options that let you examine and influence the query plan,
and suggestions for structuring queries for optimal performance, see Chapter
3, “Optimizing Queriesand Deletions,” in Sybase | Q Performance and Tuning
Guide.

Sybase |Q is designed to work best with denormalized schemas common in
datawarehouse design. In atraditional relational database, normalization aids
the goals of transaction processing by removing redundancy and improving
consistency. In a data warehouse, especially avery large one, you need to be
more concerned with the speed of processing queries against enormous
amounts of data. For a discussion of denormalization and Sybase |Q, see
“Denormalizing for performance” in Sybase IQ Performance and Tuning
Guide.
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UNION ALL views
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Tables with avery large number of rows can take a very long timeto load. To
resolve thisissue, you can use a UNION ALL view. Sybase 1Q letsyou
partition tables by splitting the datainto several separate base tables (for
example, by date). You then join them back together into a logical whole by
means of aUNION ALL view.

UNION ALL views are simple to administer. If the data is partitioned by, for
example, month, you can drop an entire month’s worth of data by deleting a
table and updating the UNION ALL view definition appropriately. You can
have many view definitions for ayear, a quarter, and so on, without adding
extra date range predicates.

For information on establishing UNION ALL views, and recommendationsfor
optimizing queriesthat reference these views, see“Using UNION ALL views
for faster loads’ in Sybase 1Q Performance and Tuning Guide.

Sybase 1Q



CHAPTER 2 Running Sybase 1Q

About this chapter This chapter tells you how to use Sybase 1Q to start the database server,
start the database, and connect to the database.

Contents Topic Page
Starting the database server 31
Running the server as a Windows service 45
Using command-line switches 45
Monitoring server activity 59
Stopping the database server 62
Restarting multiplex servers with Sybase Central 66
Starting and stopping databases 66
Starting the asiqdemo database 68
Starting and stopping Sybase Central 68

Starting the database server

Sybase |Q givesyou great flexibility in performing these three steps. This
chapter explains options for steps 1 and 2 and suggests which to choose,
depending on your situation. The next chapter explains options for step 3.

Thefirst step in running Sybase 1Q is to start the database server.
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You can start the server in al of these ways:

Start the server with the Sybase-provided utility, start_asiqg. See “ Starting
servers with the startup utility” on page 33.

Note See“Rulesfor running multiplex servers’ on page 34 before
starting a multiplex server.

Run the Start Database Server wizard in Sybase Central. See “ Starting
servers with Sybase Central” on page 35. To start and stop multiplex
servers interactively, always use Sybase Central.

Start the server from the Windows Start menu. See “ Starting serversfrom
the Windows Start menu” on page 44.

Start the server and the sample database with a Sybase-provided
configuration file. See “ Starting the asiqgdemo database” on page 68.

Place a server startup command in a shortcut or desktop icon.

Note You can aso configure Windows systems to start an 1Q server
automatically when the system is booted. For details, see “Installing
Sybase 1Q as a Service” in Sybase 1Q Installation and Configuration
Guide.

Include a server startline in an ODBC data source. See “ Creating and
editing ODBC data sources’ on page 97.

Include a server startline in a utility command.

Issue a SQL command from Interactive SQL to start an additional server.
See " Starting a server from DBISQL” on page 58.

Note If you will be using remote data access capabilities to insert datafrom
other databases or to issue queries to other databases, see Chapter 16,
“Accessing Remote Data” and Chapter 17, “ Server Classes for Remote Data
Access.”

32
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Starting servers with the startup utility

Sybase recommends that you use the startup utility, start_asiq or Sybase
Central to start servers. This command-line utility runs on all platforms, and
ensures that all required parameters are set correctly, except in special
situations described | ater in this chapter.

The genera form for the startup utility is asfollows:

start_asiq [ server-options ] [ database-file
[ database-options ], ...]

The elements of this command line are as follows:

e server-options include the database server name and other options that
control the behavior of the server, for all databasesthat are running on that
server.

« database-file isthe file name of the Catalog Store. You can omit this
option, or enter one or more database file names on the command line.
Each of these databases is |oaded and available for applications. If the
starting directory contains the database file, you do not need to specify the
path; otherwise, you must specify the path. You need not specify the .db
file extension.

« database-options are options that you can specify for each database file
you start, that control certain aspects of its behavior.

In exampl es throughout this chapter where there are several command-line
options, we show them for clarity on separate lines, asthey could be writtenin
aconfiguration file. If you enter them directly on a command line, you must
enter them all on oneline (that is, without any carriage returns).

See “Using command-line switches’ on page 45 for a descriptions of
configuration files and commonly used options.
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You can choose from many command-line switchesto specify such features as
permissions required to start a database or stop the server, and the network
protocolsto use. The command-line options are one means of tuning Sybase
IQ behavior and performance.

Note For ease of use, start the database and server together, by specifying the
database name when you start the server. The server takes its name from the
database name by default, or you can specify a different name for the server.
See “Naming the server and databases’ on page 47 for more information on
server and database names.

To start the server without starting any database, omit the databasefile from the
start_asiq command and specify a servername. If you omit the database name,
you must namethe server explicitly using the-n server switch. Use thismethod
when you create or restore a database, or when you only want to control
starting and stopping the server, leaving database use to client software.

[Starting the server using the startup utility
1 Changeto awritable directory.

2 Runthestart_asiq utility at the system prompt. The simple form of this
command is:

start_asiq servername [ database ]

This command starts the named server as a background process, starts the
named databaseif you specify it, and setsall required startup options. Oncethe
server starts, it sends amessageto the window or console where you started the
server indicating that the server isrunning. It also displays other information
about your server environment, as well as “possible problems’ messages on
failureto start. For an example of the version string and other startup messages,
see “Message logging” in Chapter 1, “Overview of Sybase 1Q System
Administration.”

All server messages go to the server log. By default, is$ASLOGDIR is
defined, the server log isin $ASLOGDIR/servername.nnn.srviog, where nnn
isthe number of timesthe server hasbeen started. You can also namethe server
log using the -o startup option.

Rules for running multiplex servers

To start and stop 1Q multiplex serversinteractively, use Sybase Central. To start
IQ multiplex serversin scripts, you may use command line parameters.
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Make sure that you follow these rules:

¢ ThelQ Main storeisconfigured for read/write use by only one designated
write server. 1Q will refuse to start with read/write access unless the
connection specifies the designated write server. The database is
configured for multiplex operation when the first query server is defined.

¢ Query servers can only be run on amultiplex database.

* Review and edit the params.cfg filein the database directory for the server
before starting it. For more about params.cfg, see Table 2-1 on page 45.

If you use Sybase Central to start the database:

¢ Removeany -n switch in a params.cfg file used to start a multiplex
database.

¢ Theconfiguration file must be named params.cfg.

« Theconfiguration file must be located in the same folder or directory as
the database (.DB) file.

e Theconfiguration file must not contain -n to name the server, or the
database name or path.

Starting servers with Sybase Central

Sybase Central, the graphical administration tool, runs on al platforms
supported by 1Q.

To run Sybase Central, you must configure and run the Sybase 1Q Agent, as
described in “ Running the Sybase 1Q Agent” on page 35.

Running the Sybase IQ Agent

An agent isaprocess that runs on aremote machine and acts on behalf of a
client. The Sybase 1Q Agent, also called the |Q Agent, enables Sybase Central
to:

e Start/stop servers
e Accesslogfiles

e Perform system functions

System Administration Guide 35



Starting the database server

These functions are required by all 1Q database administrators. If you have a
multiplex database, the 1Q Agent must be running on each machine in your
multiplexin order to fully administer aremote 1Q server. Sybase Central can be
running while you start and stop 1Q Agents.

This section givesinstructions on running the 1Q Agent on both UNIX and
Windows platforms.

Specifying the host for the IQ Agent on UNIX

When you use scriptsto start the 1Q Agent, usethe the -host parameter to
specify the host name explicitly.

To start the agent using the host name returned by uname -n use the optional -
host parameter, as follows:

S99SybaseIQAgentl2 -host
To start the agent using the host’s alias enter:
S99SybaseIQAgentl2 -host <foo>

where foo is an alias present in the /etc/hosts file.

Configuring the 1Q Agent to start automatically

Configuring the 1Q
Agent on UNIX

Configuring the Agent
on Windows

Changing the Agent
port number

36

To enable automatic startup for the |Q Agent, the system administrator must
place the following file in the UNIX startup directory (usually /etc/rc*):

SASDIR/bin/S99SybaseIQAgentl1?2

Afteryouinstall Sybase|Q and movethefile, thelQ Agent startsautomatically
whenever you reboot your system.

On Windows systems, the installation program sets up the Agent to start
automatically each time you reboot the machine. The filenameiis:

SybaseIQagentl2.exe

ThelQ Agent port number defaultsto 1099. You can override the default value,
provided that you do so before the plug-in starts. Changing the default port
number lets you to run any number of 12.7 1Q Agents on a given host, or run
IQ Agentsfor Sybase 1Q 12.5, 12.6, and 12.7 on the same host. Use the
ASIQPORT enviornment variable or the -port command line parameter to
override the default 1Q Agent port number. You can aso specify the port per
server within Sybase Central, or override the value on the Sybase Central
startup command, for example:

scjview -DASIQPORT=3356
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Overriding the IQ Agent Port Number

Overriding the 1Q OnUNIX, you can overridethelQ Agent port number on the startup command
Agent Port Number on line; for example:
UNIX ’ )

$SASDIR/bin/S99SybaseIQAgentl2 -port nnnn
Overriding the IQ On Windows, use the Service Manager, as follows:
Agent Port Number on
Windows 1 Select the name Sybase IQ Agent 12.
2  Click the Propertiesicon or choose Action > Properties from the menu bar.
3 Click Stop under Service status to stop the agent.
4

In the Start Parameterstext box, type -port nnnn where nnnn isthe port
number.

5 Click Start to restart the agent.

If the agent fails to start on Windows, check the event log for diagnostic
information.

Setting permissions for the IQ Agent

Setting the The S99Sybasel QAgent12 script should be owned by the same UID that is
permissions on UNIX used to run all the servers. Do not use the root user account.

Setting the On Windows, you must change the owner of the Sybase 1Q Agent. The user
\F/)\%rglosv?,lsons on who starts the |Q Agent will be the creator and owner of multiplex databases

and server directories, and must have write privileges on al of the serversin
the multiplex. By default, the System account starts the Agent.

[IChanging the user
1 Choose Administrative Tools> Services.
2 Right-click “Sybase 1Q Agent” and choose Start.
3 Onthe General tab, choose Automatic for Startup Type.
4

OntheLog Ontab, changethe L og on as: option from the System A ccount
to This Account.

5 Type domain\username for an account with the appropriate privilegesin
the account text box.

or
Browse to select an account, then click OK.

6 Typeand reconfirm that account’s password, then click OK.
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Troubleshooting 1Q Agent startup
Agent startup on UNIX To check if the Agent is running, run the stop_asiq utility:

stop_asig -agent
Checking system ...

The following 1 agent (s) are owned by 'ciaran'
## Owner PID Started CPU Time Additional Information

- 1: ciaran 6669 Sep.0l1 5:11 PORT:1100 java -Diqg.agent=/work/sybasel27/ASIQ-
12_7/java/IQAgentl2.jar
-Di g.agent log=/
-- Do you want to stop the agent displayed above <Y/N>?
Y

This output shows that user ciaran is running the Agent.

Should you ever receive an error that the Agent is not running, change
directory to $ASDIR/bin, and type s99sybaseTQagent12 to restart the Agent.

Agent startup on If you receive an error message that the Sybase 1Q Agent is not running, open

Windows the Services utility under Control Panel. If IQ Agent does not have the status
“Started,” click Start. Restart Sybase Central after starting the Agent.

IQ Agent Log If you experience any problems with Sybase Central, check the IQ Agent log
file

» If the user explicitly set the 1Q Agent port, thelog nameis:
%ASDIRY0\l ogfiles\Sybasel QAgent_pppp.nnn.log where pppp is the port
number and nnn is the number of times you have started the Agent since
the directory was last cleaned out.

» If thedefault 1Q Agent port (1099) is used, the log nameis:
%ASDI R0\l ogfiles\Sybasel QAgent_nnn.log where nnn is the number of
times you have started the Agent since the directory was last cleaned out.

On UNIX systems, thefileis created in the $ASLOGDIR directory by default,
and running $ASDIR/bin/S99SybaseIQagent12 displaysastatus line with
thelog file location.

Running the Start Database Server wizard

[IStarting a non-multiplex server
1 Loginusing an account with DBA privileges.
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2 Start Sybase Central,
To start Sybase Central on UNIX, type:
% scjview

To start Sybase Central on Windows, run Sybase > Adaptive Server 1Q 12
> Sybase Central Java Edition from the Programs menu.

In the left pane of Sybase Central, select Sybase 1Q.
On the Utilities tab, double-click Start Server.

Click Next. Starting a single server is the default.

o 00 b~ W

The information that you specify on the Connection Parameters screen is
used each time you start the database.

Connection profiles store parameters to help you connect faster. If a
Connection Profile exists, choose it from the dropdown, and click Next.

If no Connection Profile exists for the server, supply connection
parametersin the appropriatetext boxes. (Thewizard createsa Connection
Profilefrom these parametersif you request it on the summary screen.) Do
not use connection profilesto start multiplex servers.

To change default information, simply select it and type over it. In general,
the default User ID and password are sufficient; changing the User ID
from DBA to another user limits functionality.

Always change the default port number for each server to a different
number that is not in use.

L LA\ Start Server Wizard - Connection Parameters ] |

Specify connection information For the server to be started.

Connection Profile: I <Other = LI

Server Mame: Ijanedwxp_asiqdemo

Host Machine: Ijanedwxp

Paort Mumber: I????
Agent Port: |3456|

Database Mame: Iasiqdemo

‘What user account {with DBA authority) do vou want to use?

Username: IDBA

Password: I***

< Back | Mext = I Einiish | Cancel Help
7  After supplying parameters, click Next.

System Administration Guide 39



Starting the database server

On the Database Path screen, type the database name and path, or use the
Browse key to choose a database on the local host.

%Start Seryer Wizard - Database Path

x|

Specify the path to the Database File:
IC:'l,Program Files\Sybase\as1Q-12_aldemaolasiqgdemo.db

Browse. .. |

This path should exist locally on the given
host.

If this database is strongly encrypted, an encryption key will be
needed to start it

Encryption key: |**********

< Back | Mexk = I
If the database is encrypted, type the encryption key in the box.

Einiish | Cancel | Help |

8 Click Next. The Summary screen lists the settings you specified. Server
options listed below the line are highlighted if selected, dimmed if not.
Click the checkbox to create a connection profile that specifiesthe
parameters in the summary for future connections.

%Start Server Wizard - Summary

Server Mame:
Host [ Port;
Database Mame:

Database File:

x|

janedwxp_asiqdemo
janedwxp | 7777
asigdemo

Ci\Program Files|SybaselASIg-12_sidemoia. ..

v iCreate Connection Profil

anedwxpas

Start allikodes

Press the Finish button ko Start the Server
< Back | Texk > | Finish I

9 Click Finishif you are satisfied with optionsyou specified. If not, click the
Back button to change information.

Cancel | Help |
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[ IStarting all servers in a multiplex

An 1Q multiplex is amultiserver configuration that supports queries against a
shared database from servers with a shared disk subsystem for acommon |Q
Store. You gain additional CPU power and memory space for processing
gueries by attaching more systems to the shared disk array.

To use Sybase Central to start multiplex serversinteractively.
1 Loginusing an account with DBA privileges.
2 Start Sybase Central,
To start Sybase Central on UNIX, type:
% scjview

To start Sybase Central on Windows, run Sybase > Adaptive Server 1Q 12
> Sybase Central Java Edition from the Programs menu.

3 Intheleft pane of Sybase Central, select Sybase 1Q.
4 Select Tools> Sybase |Q > Start Server (ALT+T, 1, S)

Updates are made on only one server in amultiplex, the write server.
Queries are usually submitted to al serversin the multiplex.

The wizard opens with starting a single server selected by default. Click
the “ All serversin multiplex” option button to start them all.

5 Click Next.

The wizard next displays a series of screens prompting you for server
information. When starting all of the serversin a multiplex, supply
information for the write server. Check all information carefully.

%Start Seryer Wizard - Connection Parameters 5]

Specify connection information For the server to be started.

Connection Profile: I <Other = ﬂ

Server Mame: sterverﬂl

Host Machine: Imyhost

Port Mumbet: I6335

Database Mame: Impxdb

‘What user account {with DEA authority) do vou want to use?

Username: IDBA

Password: |***

< Back | Mext = I Einiish Cancel Help
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At the bottom of the screen are five command buttons: back, next, finish,
cancel and help. These buttons are the same throughout the rest of the
wizard and will not be described again

Theinformation that you specify on this screen is used each time you start
the database. To change default information, simply select it and type over
it. In general, the default User ID and password are sufficient; changing
the User ID from DBA to another user limits functionality.

Always change the default port number for each server to a different
number that is not in use.

Click Next.

If thedefault 1Q Agent port isalready in use, the screen displaysagainwith
an additional text box where you must specify an 1Q Agent port for this
connection. If necessary, type an 1Q Agent Port and click Next.
]

%Start Seryer Wizard - Connection Parameters

Specify connection information For the server to be started.

=l

Connection Profile: I <Cther

Server Mame: sterverDl

Host Machine: Imyhost

Paort Mumber: I6335
Agent Port: I

Database Mame: Impxdb

‘What user account {with DBA authority) do vou want to use?

Username: IDBA

Password: I***

< Back | Mexk = I

Einiish | Cancel | Help |

If the default 1Q Agent Port isnot in use, it is used for this connection.
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7 Click Next.

@Start Server Wizard - Database Path I x|

Specify the path to the Database File:
[Pk frpocfustripsdb. db

This path should exist locally on the given host,

If this database is strongly encrypted, an encryption key will be
needed ko stark it

Encryption key:

< Back | Mext = I Firisti | Cancel | Help |

8  Specify the path to the database file on the write server. You may use the
Browse button to locate the file. If thereis an encryption key for the
database, type it in the space provided.

9 Click Next. The next screen summarizes startup settings. Options are
listed below the line. They will be highlighted if selected, dimmed if not.

%Start Server Wizard - Summary 1 5]

Server Mame:  winwooddl

Host [ Port:  winwood [ 6335

Database Mame: mpxdb

Database File:  fwork/mpsxfw/mpxdb.db

Start All Nodes

Press the Finish button ko Start the Server

Texk > | Finish | Cancel | Help |

Note Sybase Central uses the params.cfg file to start the server, and
requiresthat thisfile existin the directory wherethe 1Q Catalog (.DB file)
resides. You may customize thisfile for each server.
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10 Click Finishif you are satisfied with options you specified. If not, click
the Back button to change information.

Starting servers from the Windows Start menu

This section describes methodsfor starting the database server that are specific
to Windows systems. You can also use any of the generic methods described
elsawhere in this chapter.

The easiest way to start the server on Windowsis from the Start menu. Select
Programs > Sybase > Adaptive Server 1Q 12.

From here, you can start the Sybase |Q Demo database, Sybase Central,
Interactive SQL Classic, and Interactive SQL Java.

You can a'so place databases of your own in the Program group.

Restarting servers when the Windows host is restarted

Synchronizing
multiplex servers

44

Use the Sybase 1Q Service Manager to define a service that will start an 1Q
server. You can then configure the service to start the server automatically
whenever the host is started. The service may start either non-multiplex or
multiplex servers.

Sybase Central provides script filesfor unattended operations. To create these
scripts, open the Multiplex folder, right-click a server name, and choose
Generate Admin Scripts. This creates scripts in the database directory for the
selected server.

Scripts created on the query server include sync_server.bat, which processes
the query server side of a synchronization. Thisincludes copying the database
file from the active write server and restarting the query server.

Scripts created on the write server include sync_gnode.bat, which processes
the write server side of synchronization. Edit the sync_gnode.bat script for
instructions on running these scripts in the proper order. Currently, Sybase
does not provide away to run the sync_gnode.bat script as a service.
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Running the server as a Windows service

You can run the server as a service under Windows. This allowsit to keep
running even when you log off the machine. For details of this and other
Windows-specific features, see the Sybase 1Q Installation and Configuration
Guide.

Using command-line switches

You use command-line switches to define your Sybase |Q environment. For a
completelist of command-line switchesand full referenceinformation on them,
see Chapter 1, “ Running the Database Server” in Sybase 1Q Utility Guide.

Some of the valuesyou can set with command-line options can also be changed
with the SET OPTION command. For details of this command and its options,
see the Sybase |Q Reference Manual.

Displaying command- To display all of the available command-line switches, enter one of the
line options following commands at the operating system prompt:

¢ OnUNIX systems, enter:
start _asiqg -h
e On Windows systems, enter:

start_asiq /?

Case sensitivity Command-line switches are case sensitive.
Using configuration If you use an extensive set of command-line switches, you can storethemin a
files configuration file, and invoke that file on a server command line. Specify

switchesin the configuration file as you would on the command line, with the
exception that you can enter switches on multiple lines.

Sybase |Q installs several configuration files.

Table 2-1: Configuration files

Filename | Location | Use

asiqdemo.cfg $ASDIR/demo (UNIX), Configuration file for starting the sample database,
%ASDIRY%\demo asigdemo.
(Windows)
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Filename Location Use
default.cfg $ADIR/scripts (UNIX), | Generic configuration file. Thisfileis used for default
%ASDI RY%\scripts options for start_asiq and multiplex startup. Sybase |Q
(Windows) copiesit into each new database directory and renames it
params.cfg. Changesto default.cfg (in the scripts
directory) areinherited by all databases created after the
fileis changed.
params.cfg Database directory Configuration file for user-created databases. Changes to

Required command-
line options
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thisfile affect only the server that uses this particular file.

You can use these files as templates to create your own. For example, the
following configuration file starts the database mydb.db on the database server
named Elora, with a 32MB cache, with a 20 minute checkpoint interval,
allowing anyoneto start or stop databases and |oad data, with user connections
limited to 10, a catalog page size of 4096 bytes, default client connection
timeout of 72 hours, with TCP/IP as a network protocol and a specified port
number of 1870:

-n Elora -c 32m -gc 20
-gd all -gl all -gm 10 -gp 4096 -ti 4400 -x
tcpip (port=1870) path\mydb.db

You could use these command-line options as follows:
start_asiqg @mydb.cfg

In examples throughout this chapter where there are several command-line
switches, we show them for clarity on separate lines asthey could bewrittenin
aconfiguration file. If you enter them directly on a command line, you must
enter them all on oneline.

Note When you stop the server with the DBSTOP command, you need to
specify the same parameters as when you started the server. Using a
configuration file to start the server ensures that you will be able to find these
parameters when you need them.

While most of the command-line switches described in Chapter 1, “Running
the Database Server” in Sybase | Q Utility Guide are optional, you must specify
the -n switch to run Sybase | Q effectively.

Sybase 1Q


mailto:@mydb.cfg

CHAPTER 2 Running Sybase 1Q

Default configuration
file

Configuration file for
the sample database

Naming restrictions

For this release, the default.cfg file contains all recommended server startup
values.

Note Onall 32-bit platforms, -c 32M isrecommended. On all 64-bit platforms
-c 48M isrecommended.

If you use TCP/IP to connect to the server, you should include network
connection parameters as well. If you start the server without the parameter
-x 'tepip(port=nnnn)' set, then the server uses the default TCP/IP port number
2638. If you specify a port number that is already in use, the server assigns a
different one automatically.

The default configuration file contains all of the required switches. Thisfileis
used to start servers by Windows services and Sybase Central, and isthe source
for the params.cfg file used by the UNIX start_asiq command. You can
override switches in configuration files by specifying new switches on the
start_asiq command line, except for the -n servername switch.

The asiqgdemo.cfg file, which you use to start the sampl e database, sets startup
switches to the recommended defaults. Thisfileisinstalled in $ASDIR/demo
on UNIX or %ASDIR%\demo on Windows.

Do not use hyphenated names or reserved words for database names, user
identifiersor server names, even enclosed in quotation marks. For example, the
following are not allowed:

grant
june-1999-prospects
“foreign”

For acompletelist of reserved words (keywords), seethe Sybase | Q Reference
Manual.

Naming the server and databases

You must use the -n command-line switch as a server switch (to name the
server). Thispreventsyou from unintentionally connecting to thewrong server.

You may also use the -n switch as a database switch (to name the database).
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Default names

Naming databases

Naming the server
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The server and database names are among the connection parametersthat client
applications can use when connecting to a database. On Windows, the server
name appears on the desktop icon and on the title bar of the server window.

Note While you can start more than one database, Sybase strongly
recommends that you run only one database on an IQ server. If you must run
multiple databases, start each one on a separate 1Q database server, and on a
different port.

If no server name is provided, the default server name is the name of the first
database started.

You can name databases by supplying a -n switch following the database file.
For example, the following command line starts a database and namesit:

start asig -n MyServer mydb.db -n MyDB

Naming a database | ets you use a nicknamein place of afile namethat may be
difficult to remember.

You namethe server by supplying a-n switch beforethefirst databasefile. (The
rest of the parameters are added from the default.cfg file.) For example, the
following command line starts a server named Cambridge_sample and the
sample database on that server:

start asig -n Cambridge sample sample.db

Each server name must be unique acrossthelocal area network (domain). This
prevents you from unintentionally connecting to the wrong server. The host
name and port number combination does not uniquely identify the server.
Appending aunique identifier to the server name is a useful convention. Itis
especially important in a multiuser, networked environment where shared
memory will be used for local database connections. This convention ensures
that all userswill be able to connect to the correct database, even when other
databases with the same name have been started on other host systems.

To allow Sybase |Q to locate the server no matter what character setisin use,
include only seven-bit ASCII (lower page) charactersin the server name. For
more information on character sets, see Chapter 11, “International Languages
and Character Sets’

Specifying a server name lets you start a database server with no database
loaded. The following command starts a server named Galt with no database
loaded:
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Case sensitivity and
naming conventions

start asig -n Galt -gm 10 -gp 4096

Note Although you can start aserver by relying on the default server name, it
is better to include both the server name and the database name, and to make
the two names different. This approach helps users distinguish between the
server and the databases running on it. You must specify the server namein
order to start the server without starting a specific database.

For information about starting databases on arunning server, see* Starting and
stopping databases.”

Server names and database names are case insensitive on Windows, and case
sensitive on UNIX.

You should adopt a set of naming conventions for your servers and databases,
aswell asfor all other database objects, that includes a case specification.
Enforcing naming conventions can prevent problems for users.

Controlling performance and memory from the command line

Several command-line options can aff ect database server performance. M ost of
the options described in this section control resources for operations on the IQ
Store, which can have amajor impact on performance. Optionsthat affect only
the resources available for operations on the Catalog Store may have a minor
impact on overall performance. If you need to specify options that affect the
Catalog Store only, see the Sybase |Q Reference Manual for more information.

Performance tuning suggestions are given throughout this guide. See Sybase
1Q Performance and Tuning Guide for afull discussion of how Sybase |Q uses
memory, disk, and processors, the effect of user connections on resource use,
and options you can set to control resource use.

Setting memory options

Sybase |Q uses memory for avariety of purposes:
« Buffersfor dataread from disk to resolve queries
« Buffersfor dataread from disk when loading from flat files

«  Overhead for managing connections, transactions, buffers, and database
objects
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1Q buffer cache sizes

Concurrent users
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The options discussed below, as well as other options you can set once the
server isrunning, determine how much memory isavailablefor these purposes.

The default 1Q buffer cache sizes of 16M B for the main cache and 8M B for the
temporary cache are too low for any active database use. You need to set the
buffer cache sizes for the IQ main and temporary stores in one of two ways.

»  Tosetbuffer cache sizes server-widefor the current server session, specify
the server startup options -igmc (main cache size) and -igtc (temp cache
size). Recommended method.

*  Toset cache sizesfor adatabase, you can use the SET OPTION command
to set the Main_Cache_Memory_MB and Temp_Cache_Memory_MB
database options. This method only lets you set values less than 4GB.

In both cases, you must restart the server for the new cache sizesto take effect.
If you set 1Q buffer cache sizes higher than your system will accommodate,
however, Sybase |Q cannot open the database.

The server options (-igmc and -igtc) override the database option settings. They
aso let you use as much memory as your system allows, the only limit being
the amount of physical memory on the machine. For this reason, on 64-hit
systems you should use -igmc and -igtc.

The cache sizes set by -igmc and -igtc apply to all databases started until the

server isshut down. So for example, if you set both -igmce and -igtc to 500 (MB)
and start one database at server startup and another database later on the same
server, you need at |east 2GB available for the two main and two temp caches.

Your license sets the absol ute number of concurrent users. However, you must
also set the -gm switch. This required switch lets you limit the number of
concurrent user connections on a particular server.

The -gn switch sets the number of execution threads that will be used for the
Catalog Store and connectivity while running with multiple users. It appliesto
al operating systems and servers.

On Windows, start_asiq calcul ates the val ue of this parameter and setsit using
the following formula:

gn value = gm value + 5)
Specify a minimum of 25.

On UNIX platforms, see the Sybase 1Q Installation and Configuration Guide
for your platform for more information.
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Concurrent queries

Wired memory

Number of processing
threads

Number of processors

Catalog Store cache
size

There may be times when you want to tune performance for a particular
operation by limiting the number of user connectionsto fewer than your license
alows. Alternatively, you may want to use the -iggovern switch to control
query use; see " Concurrent queries.”

The -iggovern switch lets you specify the number of concurrent querieson a
particular server. Thisis not the same as the number of connections, whichis
controlled by your license. By specifying the -iggovern switch, you can help IQ
optimize paging of buffer dataout to disk, and avoid overcommitting memory.
The default value of -iggovern is (2 x the number of CPUs) + 10. You may need
to experiment to find an ideal value. For sites with large numbers of active
connections, try setting -iggovern slightly lower.

The -igwmem switch creates apool of “wired” memory on certain UNIX
platformsonly. For details, see “ Platform-specific memory options’ in Sybase
1Q Performance and Tuning Guide.

Warning! Use this switch only if you have enough memory to dedicate some
of it for this purpose. Otherwise, you can cause serious performance
degradation.

Usethe-igmt switch to set the number of processing threadsthat Sybase IQ can
use. Sybase |Q assigns varying numbers of kernel threads to each user
connection, based on the type of processing being done by that process, the
total number of threads available, and the setting of various options. Increasing
the number of threads can improve performance.

If you are running on a multiprocessor machine, you can set the number of
processors used by the database server for Catal og Store operations with the -gt
option. By default, all available processors are used.

Use the -¢ switch to set the amount of memory in the cache for the Catalog
Store.

The start_asiq command, and the asiqdemo.cfg and default.cfg configuration
files set the -c parameter to 48MB on 64-bit systems and 32MB on 32-bit
systems. Sybase recommends using one of these methods.

If you start the server without using start_asiq, asigdemo.cfg or default.cfg, the
defaultinitial cache sizeiscomputed based on the amount of physical memory,
the operating system, and the size of the database files. The database server
takes additional cache for the Catalog when the available cache is exhausted.
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Any cache size lessthan 10000 is assumed to bein KB (1K =1024 bytes); any
cache size 10000 or greater is assumed to bein bytes. You can also specify the
cache sizeasnK or nM.

Warning! To control Catalog Store cache size, you must do either of the
following, but not both, in your configuration file (.cfg) or on the UNIX
command line for server startup:

e Setthe-c parameter

»  Set specific upper and lower limits for the Catalog Store cache size using
the -cl and -ch parameters

Do not specify other combinations of these parameters.

Note The cache sizefor the 1Q Store does not rely on the Catalog cache size.
See“1Q buffer cache sizes’ on page 50.

For more information on setting the Catal og cache size, seethe-c, -ca, -ch, and
-cl server optionsin “ Starting the database server” in Sybase |Q Ultility Guide.

Setting the number of CPUs
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The -ignumbercpus switch on the Sybase 1Q startup command lets you specify
the number of CPUsavailableto I Q. It overridesthe physical number of CPUs
for resource planning purposes. The value of the parameter defaultsto the total
number of CPUs, but the range of available valuesis 1 through 128.

Note Sybase recommends using -ignumbercpus only in the following
situations:

«  Onmachineswith Intel® CPUs and hyperthreading enabled, setting
-ignumbercpus to the number of CPUs available

*  On machines where an operating system utility has been used to restrict
Adaptive Server 1Q to a subset of the CPUs within the machine

Setting -ignumbercpus higher than the number of available CPUs may affect
performance.
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Setting options that affect timing

Checkpoint interval Sybase | Q uses checkpoints to generate reference points and other information
that it needs to recover databases. Use the -gc switch to set the maximum
number of minutes the database server will run without doing a checkpoint.

When adatabase server isrunning with multiple databases, the checkpoint time
specified by the first database started is used unless overridden by this switch.
If avalue of 0isentered, the default value of 20 minutesis used.

Recovery time The -gr parameter lets you set the maximum number of minutes that the
database server will take to recover from system failure. \When a database
server is running with multiple databases, the recovery time specified by the
first database started will be used unless overridden by this switch.

Other performance-related options

Several options help you tune network performance. They include -gb
(database process priority on Windows), and -p (maximum packet size).

Controlling permissions from the command line

Some command-line options control the permissions required to carry out
certain global operations.

Starting and stopping The-gd option allows you to limit the users who can start or stop adatabase on
databases arunning server to those with a certain level of permission in the database to
which they are already connected:

¢ DBA — Only users with DBA authority can start an extra database.

e ALL (default in start_asiq and default.cfg) — Any user can start and stop
databases. This setting meansthat the DBA does not need to issue START
DATABASE commands. (Note that users still need permission to access a
particular database once they have started it.)
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Creating and deleting
databases

Stopping the server

Loading and
unloading databases
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*  NONE — No one can start or stop a database from Interactive SQL on a
running server.

Note If -gd ALL isnot set when you start the server, only the DBA can start
additional databases on that server. This means that users cannot connect to
databases that are not already started, either at the same time as the server, or
since then by the DBA. However, it also lets non-DBAS stop a database. For
this reason, some sites may want to change this setting to DBA on production
databases.

The -gu option limitsthe users who can create and drop databases to those with
acertain level of permission in the database to which they are connected.

*  DBA—Only userswith DBA authority can create and drop databases.
e ALL (default)—Any user can create and drop databases.
*  NONE—NO user can create or drop a database.

e UTILITY_DB—Only those users who can connect to the utility_db database
can create and drop databases. See “ The utility database” on page 26 for
information.

The -gk option limits the users who can shut down a server with the DBSTOP
utility or STOP ENGINE command:

*  DBA (default) — Only users with DBA authority can stop the server.
e ALL — Any user can stop the server.

*  NONE — No user can shut down the server with the DBSTORP utility or
STOP ENGINE command.

The -gl option limits the users who can load data using LOAD TABLE to users
with acertain level of permission in the database.

e DBA — Only userswith DBA authority can load data.
e ALL (default for start_asiq and default.cfg) — Any user can load data.
*  NONE — Data cannot be loaded.
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Setting a maximum Catalog page size

The database server cache is arranged in pages, which are fixed-size areas of
memory. Since the server uses a single cache for the Catalog Store until itis
shut down, al Catalog pages must have the same size.

A Catalog fileis also arranged in pages, of size 4096, 8192, 16384, or 32768
bytes. Every database page must fit into a cache page.

You use the -gp option to set the Catalog page size explicitly. By setting -gp to
the maximum size, 32768, you maximize the number of columns per table that
Sybase |Q can support.

By default, the server page size is the same as the largest page size of the
databases on the command line. The -gp option overridesthis default. Oncethe
server starts, you cannot load a database with alarger Catal og page size than
the server. Unless you specify -gp, you cannot load a database file with a
Catalog page size larger than the databases started on the command line.

If you use larger page sizes, remember to increase your cache size. A cache of
the same size will accommodate only a fraction of the number of the larger
pages, leaving less flexibility in arranging the space.

Note The -gp option and the page sizes listed here apply to the Catalog Store
only. You set the page size for the |Q Store in the IQ PAGE SIZE parameter of
the CREATE DATABASE command. See“ Choosing an |Q page size” for more
information.

Setting up a client/server environment
Three options can help you set up your client/server environment.
e -x specifies communication protocol options.
e -tl setsthe network connection timeout.
e i setsthe client connection timeout.
See the sections that follow for details.
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Specifying protocols
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Any communications between a client application and a database server
require a communications protocol. Sybase |Q supports a set of
communications protocols for communi cations across networks and for same-
machine communications.

The database server supports the following protocols:

»  Shared memory isused for same-machine communications, and is loaded
by default.

» TCP/IP issupported on all platforms.

»  Named pipesis supported on Windows 2000/2003/X P only. Named Pipes
is provided for same machine communications to and from Windows
client applications using ODBC or Embedded SQL, but is not generally
recommended for this purpose. Named pipesis not used for network
communications.

By default, the database server starts up all available protocols. You can limit
the protocols available to a database server by using the —x command-line
switch. At the client side, many of the same options can be controlled using the
CommLinks connection parameter.

The following command starts a server using the TCP/IP protocol:
start asig -x "tcpip"

The quotes are not strictly required in this example, but are needed if there are
spacesin any of the argumentsto -x. If you omit this switch and you are using
TCP/IP, or if you do not specify a port number, the default port 2638 is used.

You can add parameters to tune the behavior of the server for each protocol.
For example, the following command line instructs the server to use two
network cards, one with a specified port number. This command must be
entered all on one line, even though it appears on multiple lines here.

start asiqg
-x "tepip (MyIP=192.75.209.12:2367,192.75.209.32)"
path\asigdemo.db

For detailed descriptions of network communications parameters that can
serve as part of the -x switch, see “Network communications parameters’ on
page 157.
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Limiting inactive connections

Sybase 1Q uses two parameters, -tl and -ti, to determine when it should close
user connections.

Setting the default A liveness packet is sent periodically across a client/server TCP/IP

network timeout communications protocol to confirm that a connection isintact. If the server
runs for aliveness timeout period (default 2 minutes) without detecting a
liveness packet, the communication is severed. The server drops any
connections associated with that client. Thereis no warning. All activity that
falls within any open transaction is rolled back.

The-tl switch on the server setstheliveness timeout, in seconds, for all clients
that do not specify a-tl switch when they connect. Liveness packets are sent at
an interval of the (liveness timeout)/4.

You may want to set a higher value for this switch at the server level. Many
users, especially those who have used earlier versions of Sybase |Q, will not
expect to be disconnected after only 2 minutes of inactivity.

Try setting the liveness timeout to 300, together with the recommended value
for —ti discussed in the next section. Set this switch as follows:

-tl 300

If this value does not work well, try -t 1200, which sets the liveness timeout to
20 minutes.

Note Userswho are running a client and server on the same machine do not
experience a liveness timeout.

Setting the default Sybase | Q disconnects client connections that have not submitted a request for

client timeout the number of minutes you specify with the -ti switch. By disconnecting
inactive connections, this option frees any locks those connections hold. The
start_asiq default is 4400 (about 72 hours), which letsyou start long runs at the
beginning of aweekend, for example, and ensure that any interim results will
not be rolled back.

Starting a server in forced recovery mode

Should you need to restart your server after afailure, you can usually do so
using the same startup options as usual.
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On rare occasions, you may need to supply startup optionsto force recovery or
to recover leaked storage. To start the server with these options, see Chapter 2,
“ System Recovery and Database Repair,” in the Sybase 1Q Troubleshooting
and Recovery Guide.

Starting a server from DBISQL

Example

If you are already connected to arunning database server, you can start a new
server from DBISQL. Use the START ENGINE command to start a named
server from DBISQL.

Note This method is not recommended for most situations. If you use it, be
sure you are starting the server on the system you intend, that you include
appropriate server parameters in the STARTLINE, and that environment
variables are set appropriately on the system where the server will start.

Thefollowing DBISQL command, entered on oneline, starts adatabase servey,
namesit jill_newserv, and specifies the network connection, number of
connections, and Catal og page size.

START ENGINE AS jill_ newserv
STARTLINE 'start asig -x tcpip(port=5678) -gm 10 -gp
4096

Starting multiple servers or clients on the same machine
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In aproduction environment, it would be unusual to have more than one server
running on the same system, and Sybase strongly recommends against doing
this. In a development environment, however, this situation can occur.

If you run more than one server or client on the same UNIX machine, and
shared memory is enabled, you must take certain precautions to prevent users
from connecting to the wrong server.

When attempting to start a server, you may see the following message:

DBSPAWN ERROR -96 -- database engine already running
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This error indicates that the startup process is finding the shared memory
segment of a server started earlier, and is unable to create a shared memory
segment. This error may occur when either an Sybase |Q or Adaptive Server
Anywhere server isrunning. (Interactive SQL will also connect to an earlier
server if its shared memory port isvisible, evenif youintended for it to connect
toaserver started later.) You can avoid theerror if you run only one server per
system, either Sybase 1Q or Adaptive Server Anywhere.

To avoid conflicts when using shared memory, consider doing one or more of
the following:

«  Createatemporary directory dedicated to each server. Make sure that each
client uses the same temporary directory asits server by setting the
ASTMP environment variable explicitly on both systems. For details
about setting environment variables, see the Sybase | Q Reference Manual.

¢ Create adata source namein the .odbc.ini file (on UNIX) for each server
and provide detailed connection information. For details, see “Using
ODBC data sources on UNIX” on page 105.

«  Use connection strings that specify explicit parameters instead of relying
on defaults.

¢ Confirm connections by issuing the following command:

SELECT "database name is" = db name(),
"servername is" = @@servername

If you run multiple servers per system, Sybase 1Q requires that you:

e Make sure that each server has a unique name, specified with the -n
parameter on startup.

«  Make sure that each server has a unique port number, specified with the -
x parameter.

For examples using these parameters, see Sybase |Q Utility Guide.

Monitoring server activity

It may be helpful, especially for new users, to monitor server activity. Using
commands appropriate for your platform, you can direct Sybase | Q to capture
server activity inalog file.
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Server startup When you start an | Q server, a series of messages appears in the server log

messages

window. The exact set of messages you see depends on your platform and
licensed options. The following is an example of what you see on Solaris:

Starting server ig 8888 on igsun at port 8888

Run Directory : /igsunl/sybase 127/ASIQ-12_ 7/demo

Server Executable : /igsunl/sybase_127/ASIQ-12_ 7/bin/asiqgsrvi2

Server Output Log : /igsunl/sybase 127/ASIQ-

12 7/logfiles/iq 8888.001.srvlog

Server Version : 12.7.0/Mainline

Open Client Version : 12.5.1/P

User Parameters : @asigdemo.cfg asigdemo.db

Default Parameters : -c 48m -gc 20 -gd all -gl all -gm 10 -gp 4096 -ti 4400
-gn 25

I. 08/05 18:39:32. Adaptive Server IQ

I. 08/05 18:39:32. Version 12.7

I. 08/05 18:39:32. (64bit mode)

I. 08/05 18:39:32. Copyright 1992-2006 by Sybase, Inc. All rights reserved
I. 08/05 18:39:32.

08/05 18:39:32. Running on SunOS 5.8 Generic 117000-03

08/05 18:39:32. 49152K of memory used for caching

18:39:32. Minimum cache size: 49152K, maximum cache size: 262008K
08/05 18:39:32. Using a maximum page size of 4096 bytes
08/05 18:39:34. Starting database "asigdemo" (/igsunl/sybase 126/ASIQ-

12_7/demo/asigdemo.db) at Thu Aug 05 2004 18:39

I. 08/05 18:39:35. Transaction log: asigdemo.log

I. 08/05 18:39:45. TCPIP link started successfully

I. 08/05 18:39:45. Now accepting requests

New process id is 124

H H H H H
o
©
~
o
ul

Server started successfully

start_asiq log file When you start a server with the start_asiq utility, server activity islogged in
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an ASCII text file placed in the directory defined by $ASLOGDIR.Thisfile
contains the standard output from the server and the server status.

Thelog file name has this format:
your server name.###.srvlog

Each time you start the server, the number is incremented. For example, your
directory may look like this:

demo.001l.srvlog demo.002.srvlog
janedemo.001.srvlog
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Naming the server log
file

UNIX log files

For information about your most recent session, choose the log with the largest
number for the desired server. I ssue atail -f command to view thelog contents.
For example:

% tail -f demo.002.srvlog

If you don't specify alog file name or IQ cannot find the server name, the log
iswritten to SASLOGDIR/start_asig.log. If SASLOGDIR is not defined, the
log iswritten to SASDIR/logfiles/start_asiq.log.

When you run start_asiq, specify the -z option to enhance the log file with
additional information about connections. This will help new users or those
troubleshooting connection problems.

OnUNIX systems, there aretwo waysto check if aparticular server isrunning:

*  Log into the machine where the server was started, and issue the
command:

ps -eaf | grep start asig

This command returns the commands used to start the various servers, as
follows:

maryc 24836 25554 0 Feb 09 - 17:36
start_asig -c 48m -gd all -gl all

-gm 10 -gp 4096 -ti 4400

-tl 300 -igmt 450

@fnma.cfg asigdemo.db

janed 28932 38122 0 11:39:24 - 2:10
start_asiqg -c 48m -gl all

-gm 10 -gp 4096 -ti 4400

-tl 300 -n janedemo -gd all

-igmt 256 -x tcpip (port=1872)

« Usethe stop_asiq utility, described in the following section, which
displays al Sybase 1Q processes running.

On Windows systems, ook in the system tray for one or more Sybase|Qicons.
Place the cursor over each icon and read the server name.

Usethe -o parameter on the start_asiq startup command to name the server log
file, rather than using the default name of server.###.srviog. For example, to
save output to afile named results, start the server as follows:

start asig -n imyserver -o results

On UNIX platforms, an additional log file captures operating system output,
including stdout and stderr output.
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The file name has this format:
your_ server name.###.stderr

On UNIX systems, the name of the file that contains stack trace information
has this format:

stktrc-YYYYMMDD-HHNNSS #.iqg

Stopping the database server

This section discusses when you need to stop the 1Q database server, how to
stop it, controlling who can stop it, and stopping the server when you shut
down the operating system.

When to stop and restart the server
In alimited set of situations, you need to stop and restart your 1Q server:
e Toinstal anew version of Sybase IQ
*  Toreset some server command-line options

»  Tocauseasmall number of server-wide database optionsto take effect; see
“Scope and duration of database options’ on page 26 of the Sybase 1Q
Reference Manual for acomplete list

» Beforeclosing the operating system session

How to stop the server
The preferred ways to stop the database server are:

* In Sybase Central (either UNIX or Windows), right-click the server name
and choose Stop from the dropdown menu.

To shut down serversin an 1Q multiplex, open the Multiplex folder, right-
click the write server, and choose Server > Stop. You may then choose
which server(s) to stop. Click Finish.

* InUNIX, usethestop_asiq utility at the operating system command line.
For details, see “ Example — Stop a server with stop_asiq”.
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When you run stop_asiq, it displays the following message:

"Please note that 'stop asig' will shut down a server
completely without regard for users, connections, or load

process status.

For more control, use the 'dbstop' utility,

which has options that control stopping servers based on
active connections."

In Windows, click Shutdown on the database server display or right-click
the IQ icon in the system tray and select Exit.

In Windows, if the server isrun as a service, open the Service Manager in
Control Pandl. Select the service and click Stop.

Normally, you should not shut down a server whileit is still connected to one
or moreclients. If you try this, you get awarning that any uncommitted
transactions will be lost. Disconnect or close al the clients and try again.

You can also stop the database server in the following ways:
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At the operating system command line, issue the DBSTOP command with
appropriate parameters. Use the same parameters as when you started the
server. Without the proper connection parameters DBSTOP doesn't know
how to connect to the server to tell it to shut down. For details on using
DBSTOP, see Chapter 1, “Running the Database Server” inthe Sybase 1Q
Utility Guide.

In aDBISQL window or command file, issue the STOP ENGINE
command to stop a named database server.

In UNIX, in the window where the database server was started, type:

q

This command does not work if you have redirected input to a different
device.

InaUNIX cron or at job, use stop_asiq with the appropriate -stop option.
The utility stops one or all servers associated with the user who starts the
cron or at job depending on the parameter specified. The user must be the
same one who started the server. No operator prompting occurs, and no
operator action is required.

To use stop_asiq in such jobs, specify the utility with the appropriate -stop
option:

stop_asig -stop one

Setting -stop one shuts down a single server, when exactly one running
server was started by the user ID that starts the cron or at job.
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stop_asig -stop all

Setting -stop all shuts down all serversthat were started by the user ID that
starts the cron or at job.

Note You must specify the full pathname to the stop_asiq executable in
the cron statement.

Example — Stop a The following example uses the stop_asiq utility in a UNIX operating system

server with stop_asiq
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command lineto shut down an Sybase 1Q server and close all user connections
toit.

When you issue the stop_asiq command, Sybase 1Q lists all the servers owned
by other users, followed by the server(s) you own. It then asks if you want to
stop your server. For example:

% stop_asig
Checking system for ASIQ 12 Servers
The following 3 server(s) are owned by other users.

## Owner PID Started CPU Time

hsin 19895 Mar.21 1:33
start_asig -c¢ 32m -gd all -gl all -gm 10 -gn 25 -gp 4096 -ti 4400
-n hsin -x tcp
gadaily 24754 01:25:07 1286:53
start_asig -gn 25 @/expl/new.cfg asigdemo.db
-o /expl/ga
wb 28350 Apr.1l1 0:20
start_asig -gn 25 @asigdemo.cfg -o
/expl/wb/mysybasel2/asiql

The following 1 server(s) are owned by ’janed’

## Owner PID Started CPU Time

1: janed 2838 15:11:37 0:07

start asiqg -c¢ 32m -gd all -gm 10 -gn 25 -gp 4096 -ti 4400 -tl 300
@asigdemo.cfg

Please note that ’‘stop_asiqg’ will shutdown a server completely
without regard for users connections or load processes status.

For a finer level of detail the utility ’‘dbstop’ has the options
to control whether a server is stopped based on active connections.
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Do you want to stop the server displayed above <Y/N>?

To shut down the server, type v (yes). Messages like the following display:

Shutting down server (2838)
Checkpointing server (2838)
Server shutdown.

To leave the server running, type n (no). You return to the system prompt and
1Q does not shut down the server.

If no running servers were started by your user ID, Sybase 1Q displays
information about serversrun by other users, then amessage likethefollowing:

There are no servers owned by 'janed'

Example —Stop a The following example stops a server from DBISQL:
server from DBISQL

STOP ENGINE Ottawa UNCONDITIONALLY

The optional keyword UNCONDITIONALLY specifies that the database server
will be stopped even if there are connectionsto it.

Note You can stop aserver from DBISQL if you are connected as DBA to one
of the databases running on that server (including the utility _db database), or if
the server was started with the -gk ALL option.

Who can stop the server

When you start a server, you can use the -gk option to set the level of
permissions required for users to stop the server with DBSTOP or STOP
ENGINE. Thedefault level of permissionsrequired isDBA, but you can also set
thevalueto ALL or NONE. If you set it to NONE, even the DBA cannot execute
STOP ENGINE. In a production environment, Sybase strongly recommends
that only the DBA be alowed to stop the database server.

Running stop_asiq at the UNIX command line, or Shutdown on Windows
platforms, still allows you to stop the server and databases on the machine
where the server was started.
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Shutting down operating system sessions

Always stop the database server explicitly before closing the operating system
session.

If you close an operating system session where a database server is running, or
if you use an operating system command to stop the database server (other than
the UNIX command shown in the previous section), the server shuts down, but
not cleanly. Next time the database is |oaded, recovery happens automatically.
For information on system recovery, see Sybase |Q Troubleshooting and
Recovery Guide.

An example of acommand that does not stop a server cleanly is stopping the
process in the Windows Task Manager Processes window.

Restarting multiplex servers with Sybase Central

If one of the query serversin your multiplex becomes unavailable dueto a
hardware crash or other failure, you can start it from the right-click menu for
that server.

If you need to start all of the serversin the multiplex, use the Start Server
wizard for the write server.The writer’s Start Server wizard also starts all
dbremote processes for all servers selected.

Starting and stopping databases

Starting a database on
a running server
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You can start databases when you start the server, or after the server isrunning.
To start adatabase when you start the server, see” Starting the database server”
on page 31 for details.

Sybase recommends that you run only one database per server, especialy in a
production environment.

There are several ways to start a database on a running server.

* To start adatabase from DBISQL or Embedded SQL, use the START
DATABASE statement. For a description, see START DATABASE
statement [DBISQL] in the Sybase IQ Reference Manual.
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Page size limitations

Permission limitations

Stopping a database

e To start and connect to a database from DBISQL or Sybase Central, usea
datasourcethat specifiesthe databasefile. See*“Working with ODBC data
sources’ on page 95.

e To start and connect to a database when you start DBISQL from a system
command prompt, include the parameter “DBF=db-file” in the connection
parameters. See* Connecting to the sample database from Sybase Central
or DBISQL"” on page 86

e To start adatabase from Sybase Central, see Chapter 4, “Managing
Databases,” in Introduction to Sybase 1Q

* To start an embedded database, while connected to a server, connect to a
database using a DBF parameter. This parameter specifies a database file
for anew connection. The database file is loaded onto the current server.

The server holds database information in memory using pages of afixed size.
Once a server has been started, you cannot load a database that has alarger
Catalog page size or 1Q page size than the server. For this reason, you should
aways set the Catalog page size to its maximum value, 32768 bytes, with the
-gp switch.

The -gd server command-line option determines the permission level required
to start databases. By default, thisoption is set to DBA, so that only users with
database administrator privileges can start 1Q databases. However, you can
also set thisoption to ALL or NONE. ALL means that all users can start a
database. NONE means that no users, including the DBA, can start a database.

You can stop a database in the following ways:

«  Disconnect from a database started by a connection string. The database
stops automatically when the last user disconnects from it, unless you
explicitly set the AUTOSTOP connection parameter to NO.

¢ From DBISQL or Embedded SQL, use the STOP DATABASE statement.

For information, see STOP DATABASE statement [DBISQL] in the Sybase
1Q Reference Manual.
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Starting the asigdemo database

You can start the server and the asigdemo database easily, using the
configuration file that Sybase |Q provides. This configuration file, called
asiqdemo.cfg, contains all the parameters necessary to start the sample
database.

[IStarting the server and asigdemo database on UNIX operating systems

*  From acommand line, type the following command:

% cd $SASDIR/demo
% start asiqg @asigdemo.cfg asigdemo.db

These commands use the configuration file asigdemo.cfg that is created
automatically at installation. You can edit thisfile to change the parametersyou
use to start the sample database. For example, the server namein thisfileis
hostname_asiqdemo. You can rename the server to a unique name of your
choice, like janed_server.

[IStarting the server and asigdemo database on a Windows system

»  Click Start on the Taskbar, and select Programs > Sybase > Adaptive
Server 1Q 12 > Start Sybase |Q Demo Database.

Starting and stopping Sybase Central

Starting Sybase
Central on UNIX
Systems

Starting Sybase
Central on Windows
Systems
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If your system supports agraphical user interface, you will use Sybase Central
to perform many administrative tasks. This guide gives summary instructions
for using Sybase Central. For moreinformation, seethe Introduction to Sybase
IQ, or use the online help available within Sybase Central.

To start Sybase Central, change directory to $SYBASE/sybcentral and type:

% scjview

If you have added $SYBASE/ASQ-12_7/bin or $SYBASE/bin to your path, as
instructed at the end of the installation, you can issue the scjview command
from any directory.

To start Sybase Central, select Sybase > Adaptive Server 1Q 12 > Sybase
Central Java Edition from the Programs menu.
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The main Sybase Central window appears. It has two panes; the right pane
displays the contents of the container selected in the left pane. The first time
you open Sybase Central, before connecting to aserver, theright paneisempty.
To better illustrate the hierarchy, Figure 2-1 shows Sybase Central connected

to the demo database.

Figure 2-1: The Sybase Central Hierarchy
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Plug-ins for Sybase Central, such as the Sybase 1Q database management
system, occupy the first level in the Sybase Central hierarchy after the root
level. A plug-in isagraphical tool for managing a particular product. When
you install the product, you can also install its Sybase Central plug-in. When
you next start Sybase Central, the new product automatically “plugsin” to
Sybase Central and appearsin the left pane.

Connecting a plug-in

If you do not see the plug-infor Sybase 1Q inthe main Sybase Central window,
you can connect to it manually.

[IConnecting to a plug-in
1 Select Tools> Plug-ins.

2 If Sybase1Qislisted, select it and choose Load (Alt+L).
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If SybaseQ isnot listed, choose Register (Alt+R). Specify the plug-in jar
file option. Then use the Browse button (Alt+r) to find and select the file
$ASDIR/java/lQPluginl2.jar on UNIX or
%ASDIRY\java\llQPluginl2.jar on Windows.

3 Check Automatically load on startup.
4 Click OK.

Stopping Sybase Central
To stop Sybase Central, select File> Exit.
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About this chapter
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Sybase 1Q runsin aclient/server environment, in which many users can
connect to adatabase server acrossanetwork. You may be ableto connect
to more than one database server. The connection optionsyou choose must

take these factors into account.

Note You can connect from Sybase Central or dbisgl on a Windows or

Linux client to Sybase IQ on a UNIX server.
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Introduction to connections

This chapter describes how client applications connect to databases. It contains
information about connecting to databases from ODBC, OLE DB, and
Embedded SQL applications. It also describes connecting from Sybase Central
and Interactive SQL.

For more information on connecting to a database from Sybase Open Client
applications, see Chapter 15, “ Sybase |1Q as a Data Server.”

For more information on connecting via JDBC (if you are not working in
Sybase Central or Interactive SQL), see Appendix B, “Data Access Using
JDBC!’

Any client application that uses a database must establish a connection to that
database before any work can be done. The connection forms a channel
through which all activity from the client application takes place. For example,
your user ID determines permissionsto carry out actions on the database—and
the database server hasyour user |D becauseit ispart of the request to establish
a connection.

This sounds simple, but some client tools may not clearly indicate connection
status, and a failed command is your first indication that the connection does
not exist. For anovice user, a quick way to confirm the connection isby a
simple select db_name ().

To display the current database, use this syntax:
select db_name ()
To specify adifferent database, use this syntax:

select db name ([ database id 1)

How connections are established

72

To establish a connection, the client application calls functionsin one of the
supported interfaces. Sybase 1Q supports the following interfaces:

« ODBC — ODBC connections are discussed in this chapter.
 OLE DB— OLE DB connections are discussed in this chapter.

*  Embedded SQL — Embedded SQL connections are discussed in this
chapter.
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Learning about
connections

¢ Sybase Open Client — Open Client connections are not discussed in this
chapter. For information on connecting to 1Q from Open Client
applications, see Chapter 15, “Sybase 1Q as a Data Server”

« JDBC — JDBC connections are discussed in this chapter. For more
information on connecting via JDBC, see Chapter 4, “Managing
Databases,” in Introduction to Sybase 1Q. To create JDBC data sources,
see Appendix B, “Data Access Using JDBC.’

Note JDBC provides the link between the execution of Java objects and
database operations. For a description of Java support in Sybase 1Q, see
“Enabling Java in the database” on page 191.

The interface uses connection information included in the call from the client
application, perhaps together with information held on disk in afile data
source, to locate and connect to a server 